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End User License Agreement for Windows 2000

You have acquired a device (“DEVICE”) that includes software licensed by Tektronix Japan, Ltd. (“TJ”) from Microsoft
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materials, and “online” or electronic documentation (“SOFTWARE”) are protected by international intellectual property

laws and treaties. The SOFTWARE is licensed, not sold. All rights reserved.

IF YOU DO NOT AGREE TO THIS END USER LICENSE AGREEMENT (“EULA”), DO NOT USE THE DEVICE OR

COPY THE SOFTWARE. INSTEAD, PROMPTLY CONTACT TJ FOR INSTRUCTIONS ON RETURN OF THE

UNUSED DEVICE(S) FOR A REFUND. ANY USE OF THE SOFTWARE, INCLUDING BUT NOT LIMITED TO

USE ON THE DEVICE, WILL CONSTITUTE YOUR AGREEMENT TO THIS EULA (OR RATIFICATION OF
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General Safety Summary

Review the following safety precautions to avoid injury and prevent damage to
this product or any products connected to it. To avoid potential hazards, use this
product only as specified.

Only qualified personnel should perform service procedures.

Use Proper Power Cord. Use only the power cord specified for this product and
certified for the country of use.

Ground the Product. This product is grounded through the grounding conductor
of the power cord. To avoid electric shock, the grounding conductor must be
connected to earth ground. Before making connections to the input or output
terminals of the product, ensure that the product is properly grounded.

Observe All Terminal Ratings. To avoid fire or shock hazard, observe all ratings
and markings on the product. Consult the product manual for further ratings
information before making connections to the product.

The common terminal is at ground potential. Do not connect the common
terminal to elevated voltages.

Do not apply a potential to any terminal, including the common terminal, that
exceeds the maximum rating of that terminal.

Do Not Operate Without Covers. Do not operate this product with covers or panels
removed.

Avoid Exposed Circuitry. Do not touch exposed connections and components
when power is present.

Do Not Operate With Suspected Failures. If you suspect there is damage to this
product, have it inspected by qualified service personnel.

Do Not Operate in Wet/Damp Conditions.

Do Not Operate in an Explosive Atmosphere.

Keep Product Surfaces Clean and Dry.

Provide Proper Ventilation. Refer to the manual’s installation instructions for
details on installing the product so it has proper ventilation.

To Avoid Fire or
Personal Injury
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Terms in this Manual. These terms may appear in this manual:

WARNING. Warning statements identify conditions or practices that could result

in injury or loss of life.

CAUTION. Caution statements identify conditions or practices that could result in

damage to this product or other property.

Terms on the Product. These terms may appear on the product:

DANGER indicates an injury hazard immediately accessible as you read the
marking.

WARNING indicates an injury hazard not immediately accessible as you read the
marking.

CAUTION indicates a hazard to property including the product.

Symbols on the Product. The following symbols may appear on the product:

Protective Ground

(Earth) Terminal

CAUTION

Refer to Manual

Double

Insulated

WARNING

High Voltage

Symbols and Terms
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Preface

This is the user manual (volume 2)for the DTG5000 Series Data Timing Genera-
tor.

About This Manual

This manual contains information on the various function of the DTG5000
Series Data Timing Generator. This manual is composed of the following
chapters:

� The Reference explains the functions that the Data Timing Generator. is
equipped. This section also describes the concept of data timing generator
pattern data for the reference when dealing with pattern data.

� The Appendices describes the information about system recovery and setting
up the operating system and setting up the display device.
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Related Manuals and Online Documents

This manual is part of a document set of standard-accessory manuals and online
documentation. This manual mainly focuses on functional, background
information needed to use the product features. See the following list for other
documents supporting the data timing generator operation and service. (Manual
part numbers are listed in Accessories & Options section of the User manual,
Volume 1 of 2.)

Document name Description

DTG5000 Series Online Help An online help system, integrated with the User Interface application that ships with this
product. The help is preinstalled in the data timing generator.

DTG5000 Series User Manual, volume 1 Provides a “getting started” and an “operating basics” information, and gives
background information on how to use the data timing generator.

DTG5000 Series Programmer Provides complete information on programming commands and remote control of the
instrument.

DTG5000 Series Technical Reference for
Performance Verification & Specifications

Describes how to verify the performance of the data timing generator and lists its
specifications.

DTG5000 Series Service Manual Describes how to service the data timing generator to the module level. This optional
manual must be ordered separately.
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Contacting Tektronix

Phone 1-800-833-9200*

Address Tektronix, Inc.
Department or name (if known)
14200 SW Karl Braun Drive
P.O. Box 500
Beaverton, OR 97077
USA

Web site www.tektronix.com

Sales support 1-800-833-9200, select option 1*

Service support 1-800-833-9200, select option 2*

Technical support Email: techsupport@tektronix.com

1-800-833-9200, select option 3*

6:00 a.m. -- 5:00 p.m. Pacific time

* This phone number is toll free in North America. After office hours, please leave a
voice mail message.
Outside North America, contact a Tektronix sales office or distributor; see the
Tektronix web site for a list of offices.



Preface

xiv DTG5078 & DTG5274 Data Timing Generator User Manual



DTG5078 & DTG5274 Data Timing Generator User Manual 1--1

Reference

This chapter contains information on the various functions of the DTG5000
Series Data Timing Generator.

� Operating Modes

� Data Structure

� Pattern Edit

� Timing Parameters

� Output Level

� DC Output

� Trigger

� Sequence

� Jitter Generation

� DTG5000 Configuration Utility

� Master--Slave operation

� Pulse Generator Mode

� Offline Mode

� Remote Control

� Diagnostics & Calibration
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Operating Modes

This section contains the following two sections, which provides background
information on the DTG5000 Series Data Timing Generator operation.

� The Operating Modes section explains the data timing generator objects such
as channel, group, block and sequence.

� The Internal Pattern Data section explains the data timing generator objects
such as channel, group, block and sequence.

� The Grouping and Channel Assignment section explains the definition of
groups and provides basic information on how to use the Channel Group
window.

The DTG5000 Series data timing generator operates in Data Generator (DG)
mode or Pulse Generator (PG) mode.

Data Generator Mode

The DTG5000 Series operates as a data generator that outputs pattern data
repeatedly. If you have defined a sequence, the DTG5000 Series runs it
repeatedly. The DTG5000 Series uses data created with the DTG’s built--in
pattern editor or imports data created with an external simulation software tool or
other similar software, and then outputs the data. The output timing is deter-
mined by the sampling clock rate.

The following control types of the data pattern are available:

� Timing Control Delay, Width/Duty, Cross Point, Slew Rate

� Level Control: Amplitude, offset

Pulse Generator Mode

The DTG5000 Series operates as a pulse generator. A usual clock pattern is
generated as the data pattern being output. The output timing is determined by
the output frequency.

The following control types of the data pattern are available:

� Timing Control Pulse Width, Delay, Duty, Tr/Tf

� Level Control: Amplitude, offset
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Comparison

The following table summarizes comparison between the Data Generator mode
and Pulse Generator mode:

Table 1--1: Comparison between the Data Generator mode and Pulse Generator mode

Items Data Generator mode Pulse Generator mode

Data Rate
(DG mode)

Frequency
(PG mode)

DTG5078:
NRZ only: 50 kbps to 750 Mbps
contains RZ, R1: 50 kbps to 375 Mbps

DTG5274:
NRZ only: 50 kbps to 2.7 Gbps
contains RZ, R1: 50 kbps to 1.35 Gbps

DTG5078:
50 kHz to 750 MHz

DTG5274:
50 kHz to 2.7 GHz

Available slots DTG5078: A to H

DTG5274: A to D

DTG5078: A to D

DTG5274: A to D

Available windows Channel Group, Blocks, Data--Listing, Data--Wave-
form, Level, Timing, Time Base, Sequence,
Sub--sequences, Jitter Generation, DC Output

Level, Timing, Time Base, Sequence, Sub--se-
quences, DC Output

Channel Grouping Available Not available

Data Format NRZ, RZ, R1 Pulse

Timing control Delay, Pulse Width, Duty, Slew Rate, Polarity, Cross
Point

Delay, Pulse Width, Duty, Slew Rate, Polarity, Pulse
Rate

Level control
resolution

High, Low, High Limit, Low Limit, Term.R, Term.V High, Low, High Limit, Low Limit, Term.R, Term.V

Sequence operation Available Not available

Differential Timing
Offset

Available Available

Channel addition AND, XOR AND, XOR

Long delay Available Not available

Jitter generation Available Not available

The data timing generator is controlled by the DTG5000 software running on the
Windows 2000 operating system.
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Data Structure

This section contains the following two sections, which provides background
information on the DTG5000 Series Data Timing Generator data structure.

� Internal Pattern Data section explains the data timing generator objects such
as channel, group, block and sequence.

� Grouping and Channel Assignment section explains the definition of groups
and provides basic information on how to use the Channel Group window.

Internal Pattern Data

This section explains the meanings of the data included in the windows. The data
in the DTG5000 software consists of the channel, group, block, and sequence
objects. This section details them in order.

Logicalchannel

Logicalchannel

Logicalchannel

Logicalchannel

Logicalchannel

Logicalchannel

Logicalchannel

Logicalchannel

Logicalchannel

Logicalchannel

Logicalchannel

Logicalchannel

Logicalchannel

Logicalchannel

Logicalchannel

Logicalchannel

Group 01 Group 02 Group 03

1 2 3 4 1 2 3 41 2 3 41 2 3 4

Slot A Slot B Slot C Slot D

Block

Physical Channels

Channel Assignment

Figure 1--1: Channels, groups, blocks and channel assignment



Data Structure

1--6 DTG5078 & DTG5274 Data Timing Generator User Manual

The data timing generator has two types of channels: logical and physical.
Logical channels represent one-bit width pattern data. The number of logical
channels is 32 (= 4 channels x 8 slots) for DTG5078, or 8 (= 2 channels x 4
slots) for DTG5274.

Logical channels themselves do not have the concept of length. The length of the
pattern data on a logical channel is the block size defined in the Blocks window.
Each piece of the pattern data has a value of 0 or 1. To create the pattern data,
you can use the Data-Listing or Data-Waveform window.

One of the key features of the data timing generator is that each logical channel
has its attribute value of the output setting parameters such as the output level,
pulse width or delay time. You can set these parameters using the Level and/or
Timing windows.

Physical channels are defined as the hardware channels of an output module
installed in the data timing generator mainframe. Each of the DTGM10 or
DTGM20 output module installed in the DTG5078 mainframe has four physical
channels. Each of the DTGM10 or DTGM20 module installed in the DTG5274
mainframe or each of the DTGM30 module installed in the DTG5078 or
DTG5274 mainframe has two physical channels.

The number of physical channels available for the system is determined by the
mainframe type and the types and number of output modules installed.

The DTG5000 software has the output setup parameters, such as the output level
or clock frequency, in its logical channels. To perform the actual data pattern
outputs, do the following:

� First, specify the physical channels to output the data within the logical
channels.

� Next, send the output setup parameter to the physical channels to operate the
hardware properly.

To associate the logical channel with physical channel (this is also called channel
assignment), use the Channel Group window. Refer to “ Window Operation 4”

of the user manual volume 1.

Logical Channel

Physical Channel



Data Structure

DTG5078 & DTG5274 Data Timing Generator User Manual 1--7

A group is defined as a set of logical channels. Grouping function is especially
useful depending on the DUT(Device Under Test). Several channels are
sometimes used with the same output level and data format. In such case,
handling the multiple channels as one group is a useful method.

The number of logical channels that the system can accept is determined by the
mainframe (32 for DTG5078 or 8 for DTG5274). In the Master-Slave operation
mode, the number increases with the number of mainframes. The number of
groups depends on how many groups the user divides the logical channels. The
total number of logical channels of each group cannot exceed the number of
logical channels that the system can accept. By default, every logical channel is
divided into an eight-channel group. To add a new group, you have to delete
some groups or decrease the number of logical channels in a group to secure the
logical channels required for the new group.

To create, delete, rename or resize a group, use the Channel Group window.

A block is defined as a set of groups that consist of logical channels. The block
is an elementary data of signal output. To specify the block length, use the block
size located in the Blocks window. The block size represents the pattern data
length, or vector length. The block width is the sum of bit width in the group to
which it belongs, that is, the total number of logical channels.

By default, one block whose size is 1000 named Block1 is created.

Creating multiple blocks enables you to perform the repetitive signal outputs by
the blocks or sequential outputs with jumps. Even if two or more blocks exist in
the system, only one method can be used for either grouping or channel
assignment.

To create, rename or resize a block, use the Blocks window.

Use the Data-Listing or Data-Waveform window to edit values (0 and 1) in the
individual pattern data. Editing is possible by the block unit. To specify the
block to be edited, you can use Select Block... from the Edit menu of the
Data-Listing or Data-Waveform window, or use View Data-Listing or View
Data-Waveform from the Edit menu of the Blocks window.

To set the voltage output setting parameter, use the Level window. To set the
timing output setting parameter, use the Timing window. Both parameters can be
set by the channel unit (except for clock frequency), not by the block unit.

Groups

Blocks
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A sequence consists of blocks and subsequences. As the subsequence elements,
one or more block names and the repetition of the blocks are defined. Using a
sequence, you can output the complex signals by defining blocks, number of
repetition of subsequence, and jump conditions.

By default, a sequence that infinitely repeats the Block1 is provided. To create a
sequence or sub-sequence, use the sequence table in the Sequence window or
Sub-sequence window.

Sequence
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Block1 x 10

Block2 x 20

Block3 x 10

Sequence window

Data--Waveform window

Data--Listing window

0100101001110
0010001000100
110011001

Hi 1.5 V

Lo 0.0 V

Level window

Freq 375 MHz

Delay 1 ns

Duty 50 %

Timing window

Channel Group window

Group

Group

Block1

Block2

Block3

Group

Pattern Memory

A B

Hardware channels

Channel Assignment

Grouping

Output
Setup

Edit

11 2 3 4 2 3 4

Figure 1--2: Concept of data and window
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Grouping and Channel Assignment

Grouping is to collect channels in a single group to enable setup, edit or display
by group. To define a group or perform a channel assignment, use the Channel
Group window. You can use the grouping function only in the Data Generator
mode.

A group is defined by the name and the channels included in the group. The
defined group and channels are used for display by the channel or by the group
in the Data-Listing, Data-Waveform, Timing, or Level window.

The channels to be defined are logical channels but not physical channels, which
are actually installed to the hardware. The pattern data you created by pattern
edit and the setting parameters such as the voltage and/or delay are attributes
with logical channels.

To output a signal, you must assign the previously defined logical channels to
physical channels. See Figure 1--3.

� Assign only one physical channel to one logical channel.

� Channel assignment can be performed, regardless of the bit sequence in the
group; any physical channels can be assigned to logical channels as desired.

� You can define the logical channels without being assigned to physical
channels.

� The physical channels that are not assigned to logical channels do not output
any signals.

AAA:00

AAA:01

AAA:02

AAA:03

AAA

(4 bits)

BBB:00

BBB:01

BBB:02

BBB:03

BBB:04

BBB

(5 bits)

CH1

CH2

CH3

CH4

CH1

CH2

CH3

CH4

CH1

CH2

S
lotA

S
lot
C

S
lot
B

Group Logocal
Channels

Physical
Channels

Unable to use the CH1 which is
not assigned to logical channel.

You cannot assign two logical
channels to one physical channel.

The logical channel which is not
assigned to any physical channel
can be used.

Crossing is acceptable.

X

Figure 1--3: Channel assignment

Defining a Group

Assigning a Channel
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To define a group or perform channel assignment, use the Channel Group
window.

Figure 1--4: Channel Group window

The default group name(s) appear in the Group List represent the maximum
number of logical channels which can be used with mainframe, and they are
grouped by eight channel per one group. The groups are independent of the
installed output module(s).

Group Name. Assign a name to each group for identification. You can specify any
32-character or shorter string for a group. The name is case-sensitive, and the
default is GroupXX.

Definable Number. Equal to or less than the number of physical channels
supported by the mainframe. Up to 96.

Number of Channels. 1 to 96.

Predefined Grouping Options. The data timing generator provides three user-se-
lectable predefined options for grouping:

� 8 channels per group

� 1 channel per group

� All channels in one group

Channel Group Window

Group List
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To create a new group, there must be a logical channel not assigned to a group.
By default, every logical channel has been assigned to groups in the data timing
generator mainframe. You must delete several groups to make the logical
channels available before creating a new group.

1. Push the front panel MENU button.

2. Select Edit menu, and then select New Group....
Alternatively, place the mouse pointer in the Group List table and right-click,
then select New Group....

3. The Grouping dialog box appears.

4. Enter a group name and the number of bits (number of logical channels) in
the dialog box.

5. Select OK to create a new group.

You can rename an existing group or change the number of its logical channels.

1. If the Group List is not activated on the screen, activate it by pressing the
TAB key.

2. Select the target group using the Up or Down arrow key.

3. Push the front panel MENU button.

4. Select the Edit menu, and then select Rename/Resize Group....
Alternatively, place the mouse pointer in the Group List table and right-click,
and then select the Rename/Resize Group....

5. Edit the group name and the number of bits (the number of logical channels)
in the Grouping dialog box.

6. Select OK to complete the change.

Creating a New Group

Renaming and Resizing a
Group
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You can delete the particular group(s) you selected or all the groups.

1. Activate the Group List in the Channel Group window.

2. To delete a group, select the group by using the Up or Down arrow key.

3. Push the front panel MENU button.

4. Select the Edit menu, and then select Delete Group or Delete All Groups.
Alternatively, place the mouse pointer in the Group List table and right-click,
and then select the Delete Group or Delete All Groups.

5. Select the menu option (Delete Group or Delete All Groups) to display the
confirmation dialog.

6. Select OK to delete the group(s).

The following three combinations of a group and its logical channel are provided
in the data timing generator.

� 8 channels per group

� 1 channel per group

� All channels per group

To select one of these options, do the following.

1. Activate the Group List in the Channel Group window.

2. Push the front panel MENU button.

3. Select the Edit menu, and select Preset, and then select 8 Channels per
Group or 1 Channel per Group or All Channels in One Group.

Alternatively, place the mouse pointer in the Group List table and right-click,
then select the Preset, and then select 8 Channels per Group or 1 Channel
per Group or All Channels in One Group.

4. Select the menu item to display the confirmation dialog.

5. Select OK to create the group.

The physical channel is identified by the mainframe number (1 to 3; for
Master-Slave configuration), slot location (A to H), and channel number (1 to 4).

The installed physical channels are displayed in the right window pane of display
area. Any channel indicated by a bullet in a white rectangle has already been
assigned to a logical channel.

Deleting a Group

Selecting a Preset
Grouping Option

Channels
Physical Channel
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Do the following steps to perform the channel assignment.

1. Activate the Group List in the Channel Group window.

2. Select the target logical channel with the Up or Down arrow key.

3. Activate the Channels with TAB key.

4. Select a physical channel with the Up/Down/Left/Right arrow keys.

5. Push SELECT button to complete the assignment. The physical channel
name is displayed in the CH column of the Group List, indicating that the
assignment is complete.

6. For the logical channel in the left of Group List, the next lower line is
selected automatically. The channel assignments can be performed in
sequence by repeating the selection of a physical channel in the right
Channels.

You can de-assign a physical channel you selected. You can also de-assign all the
physical channels currently assigned to logical channel(s).

1. Activate the Group List in the Channel Group window.

2. To de-assign a particular channel, select the channel with the Up or Down
arrow key.

3. Push the front panel MENU button.

4. Select the Edit menu, and then select De-assign or De-assign All.
Alternatively, place the mouse pointer in the Group List table and right-click,
then select the De-assign or De-assign All.

5. A dialog box appears to prompt you for confirmation. Select OK.

6. The channels you selected are de-assigned.

Assigning a Channel

De-assigning a Channel
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Pattern Edit

This section describes how to prepare and edit pattern data

In pattern edit, you prepare or edit pattern data for each of the blocks. To perform
the edit, you can use the Data--Listing and Data--Waveform windows. They
differ only in display manners and manipulate the same data. Thus, any change
in either window is concurrently reflected in the other window.

The cursor and the markers are updated in common in a Data--Listing and
Data--Waveform window.

The selection domain has been independent although the cursor, a marker 1, and
a marker 2 are updated in the common Data--Listing window and Data--Wave-
form window.

CursorCursor

Marker1

Marker2

Selected area

Selected area

Data--Listing window Data--Waveform window

Figure 1--5: Data--Listing window and Data--Waveform window

Area

Data manipulated in the pattern edit is data contained in a two--dimensional area
that is defined by the bitwise dimension, i.e., width (horizontally in the
Data--Listing window or vertically in the Data--Waveform window), and the
dimension in the vector direction, i.e., length (vertically in the Data--Listing
window or horizontally in the Data--Waveform window). Note that performing
Paste or Shift does not resize the block.
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vector direction

vector direction

bitwise direction

bitwise direction

Data--Listing window

Data--Waveform window

MSB LSB
reference point

MSB

LSB

0
1
0
1
0
0
1

Figure 1--6: Area

Defining the Edited Area

For each editing operation, you must define the area to edit. The area is specified
by the width in the bitwise direction and the length in the vector direction.

For the width in the bitwise direction, you can specify 1 to the group width. You
cannot specify a width greater than one group. To define the range in the bitwise
direction, specify Channel or Group in the By: section associated with each edit
command dialog box. When you select By: Channel, you can specify the width
of the group indicated by the cursor or the width--in--bits you have selected using
the the cursor. When you select By: Group, you can specify the width of the
group indicated by the cursor. When you select View by Group as a viewing
mode, By: Group is selected automatically as a width of the edit area.

For the length in the vector direction, you can specify any value from 1 to the
block length. To define the range in the vector direction, specify All, Between
Markers, or Selected in the Range: section associated with each edit command
dialog box.

Table 1--2: Edited Area

Range By Vector direction Bitwise direction

All Group All Group indicated by
cursor

Channel All Channel indicated by
cursor

Between Markers Group Between two markers Group indicated by
cursor
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Table 1--2: Edited Area (cont.)

Range Bitwise directionVector directionBy

Channel Between two markers Channel indicated by
cursor

Selected Selected area Selected area (within
1 group)

Cursor

Marker1

Marker2

Edited Area

Range: All Between Markers Selected

By:
Channel

By:
Group

Marker1

Marker2

GroupX

Cursor

Edited Area

Between Markers SelectedRange: All

Marker1

Marker2

Cursor

Edited Area

Figure 1--7: Selection of edited area (View by Channel)
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Cursor and Markers

The cursor and the markers are provided to define the area edited.

The cursor defines the point to be used as the reference of the area edited. To
move the cursor, use the Up, Down, Left or Right arrow keys or the knob or
MENU button.

Figure 1--8: Move Cursor To dialog box

When moving the cursor using a menu, you can move it to the position of
Marker1, the position of Marker2, or the specified vector position.

1. Press the SELECT orMENU key to display the menu. Then, select Move

Cursor To....

2. Use the TAB key and Up or Down arrow key to select Marker1,Marker2

or Vector.

3. When you select Vector, enter the vector number where you want the cursor
to move to using the numeric keys.

4. Use the TAB key to select the OK button, then press the ENTER key. The
cursor moves to the specified position.

Moving a Cursor
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The two markers define the range in the vector direction. Use the menu to move
the markers.

Figure 1--9: Move Marker To dialog box

When moving the markers using a menu, you can move it to the position of the
cursor or the specified vector position.

1. When setting a marker as a cursor position, first move the cursor to the
specified position.

2. Press the SELECT orMENU key to display the menu. Then, select Move

Marker To....

3. Use the TAB key and arrow keys to select Marker1,Marker2 or ∆
numeric box or Cursor Pos button.

4. When you select a numeric box, enter a numeric value. By setting the delta
value, you can define the position of Marker2 relative to Marker1.

5. When you select a Cursor Pos button, press the ENTER key. The value of
the cursor position is input in the numeric box.

6. Use the TAB key to select the OK button, then press the ENTER key. The
marker moves to the specified position.

To define a rectangular area as the range edited, do the following procedure. You
must limit an area only in a single group because it cannot be defined in the
bitwise direction over more than one group.

1. Move the cursor to either end of the area.

2. While holding down the SHIFT key, press the Up, Down, Left or Right
arrow keys or turn the knob to define the area.

Moving Markers

Defining an Area
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View

The edit windows offer the following features to facilitate editing.

You can view data by channel or group. To select either one, press theMENU

key to display the View menu , and then select View by Channel or View by

Group.

The Data--Waveform window can zoom the view in or out in the vector direction
horizontally.

The Zoom In/Out feature of the window can display the view from 10 to 2560
vectors. For example, if the Data--Waveform window displays 50 vectors and
you zoom in, then 1/2 or 25 vectors will be displayed. If the Data--Waveform
window displays 50 vectors and you zoom out, then 100 vectors will be
displayed.

1. Press theMENU key to display the View menu, then select Zoom In or
Zoom Out.

2. Press the ENTER key.

If you are using the mouse, you can click on the icon on the toolbar.

Unit View
View by Channel
View by Group

Zoom
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The pattern of a Data--Waveform window is displayed with the Format, Delay,
Pulse Width, and Polarity settings you set in the Timing window.

View with Timing shows the details of pattern format, delay, polarity
and soon.

Figure 1--10: View with Timing

You can change the display order of the groups when you select the view by
group.

Select the group you want to move first. Then, press theMENU key to display
the View menu. You can move a group in the Data--Listing window by using the
Move Left orMove Right command. If you are in the Data--Waveform window,
you can use theMove Up orMove Down command.

You can select how data is listed when viewed by group.

The Data--Listing window allows you to select a radix display option. Signed
specifies whether to sign the MSB used for decimal display.

View with Timing

Display order

Properties
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Radix

Unsigned Signed

Figure 1--11: Data--Listing window properties

The Data--Waveform window allows you to additionally select magnitude
display on the view in the bitwise direction. For Magnitude , when the group
width is n bits, n--bit signed or unsigned values of the data of group are displayed
by graphically with weighting of 2n.

Unsigned
Magnitude

Signed
Magnitude

Figure 1--12: Data--Waveform window properties

Selects the block you want to display or edit in the Data--Listing and Data--Wa-
veform windows. To create a new block, you have to use the Blocks window.

1. Press theMENU key to display the Edit menu or the SELECT key to
display the pop--up menu, then select Select Block....

2. The block name defined now is displayed on a Select Block dialog box.

3. Select a block with arrow key, then press the ENTER key.

4. The contents of the selected block are displayed.

Select Block
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Edit Menu

The range which applies a command is specified by Range and By which are
displayed on the dialog box of each command.

Several Edit commands are available from the Edit menu. A pop--up menu is
displayed when you use the SELECT key and the Edit menu is displayed by the
MENU key. The range is displayed and specified in the dialog box of each
command.

Copies the pattern data from the specified range to the DTG’s own clipboard.
Because it is copied as data, you can also Paste it to a group with a different
radix display option specified.

Pastes the contents of the DTG 5000 software’s own clipboard to the location
starting from the cursor position. This command places the cursor at the top left
corner of the rectangle, i.e., at the MSB, or the position of the least vector
number. If the rectangular area in the clipboard goes out of the width--in--bits and
vector length of the group with the current cursor position as the base, an error
will occur.

Inverts data values 0 and 1 of the pattern data in the specified range.

Mirrors the arrangement of the pattern data in the specified range. You can select the
arrangement in either the vector or bitwise direction.

00111 01001 10010

10100 11100 00111

11100 10100 00101

01001 00111 11100

Mirror Vector Selected area Mirror Bit

Figure 1--13: Mirror operation

Copy...

Paste

Invert...

Mirror...
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Moves the pattern data by Value in the specified range in the bitwise direction.
If the Value is positive, the data moves toward the MSB. It cannot move in the
vector direction.

Shift. All the data going out of the above range are lost, while the empty columns
are filled with 0s

Rotate. The data going out of the range is moved to the empty columns to fill
them.

Fills the values of all the data in the specified range with 0s or 1s.

Creates a clock pattern of Low (0) and High (1) in the vector direction in the
specified range. In Low or High Step, specify the number of vectors followed by
0s or 1s, respectively. The sum of the Low and High Step values is defined as the
clock pattern cycle. For view by group, the same clock patterns are created for
each of the channels in the group.

Creates one of the six predefined patterns in the specified range. The pattern is
created in a rectangular area defined by the width--in--bits and vector length.
Therefore, if you select All or Between Markers for Range in View by Channel
display, a pattern with a width of 1 bit will be created.

Figure 1--14: Predefined Pattern dialog box

Shift/Rotate...

Fill with One/Zero...

Clock Pattern...

Predefined Pattern...
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� Binary Counter

� Johnson Counter

� Graycode Counter

� Walking Ones

� Walking Zeros

� Checker Board

In addition to the pattern type, you can specify Step, Skip, and Direction.

Table 1--3: Predefined Pattern settings

Items Description

Step Specifies the number of steps representing a counter value.

Skip Available only for Binary Counter. Specifies the number of steps not
used for counter values (this contains the initial value without being
changed). The actual one step will be the sum of Step and Skip.

Direction Selects either the Up or Down counter. The data created at a Down
counter is the reversed data created at Up counter in the direction of
a vector.

Step=1
Skip=0

Step=2
Skip=0

Step=2
Skip=0

Figure 1--15: Step and Skip
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Binary Counter Johnson Counter Graycode Counter

Walking Ones Checker BoardWalking Zeros

Figure 1--16: Predefined patterns
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Fills the specified range with the user--defined pattern. If the width--in--bits of the
specified range is smaller than that of the specified pattern, it will be filled,
starting at the LSB of the pattern. A maximum of 1,000 vectors can be specified
for the pattern. You can change the radix option of the input using Properties... of
the View menu.

Figure 1--17: User Defined Patterns dialog box

User Defined Pattern...
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Creates a pattern of a pseudo random pattern that uses the shift registers for the
specified range.

Figure 1--18: PRBS/PRWS dialog box

Figure 1--19 shows the correspondence between the pattern representations and
the actual shift registers.
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Figure 1--19: Shift register generator representation example

PRBS/PRWS...



Pattern Edit

DTG5078 & DTG5274 Data Timing Generator User Manual 1--29

Set the following in the dialog box:

Table 1--4: PRBS/PRWS dialog box settings

Items Description

Type PRBS: Pseudo random bit sequence, a random pattern with a width
of 1 bit. If you specify a range of two or more bits, the same pattern
is created for all the bits.

PRWS: Pseudo random word sequence, a two--dimensional random
pattern that consists of those patterns generated with the PRBS that
are arranged in the bitwise direction, starting at the LSB.

Pattern The 14 patterns below are available. The register numbers are
assigned, beginning at the register that will contain the feedback
(Register 1). All the registers are initialized to 1 before calculation.
For the shift register representations and the actual register image,
see Figure 1--19 on page 1--28.

PRBS5: X^5+X^4+X^2+X^1+1
PRBS6: X^6+X^5+X^3+X^2+1
PRBS7: X^7+X^6+1
PRBS8: X^8+X^7+X^3+X^2+1
PRBS9: X^9+X^5+1
PRBS9: X^9+X^8+X^5+X^4+1
PRBS10: X^10+X^7+1
PRBS11: X^11+X^9+1
PRBS11: X^11+X^8+X^5+X^2+1
PRBS12: X^12+X^9+X^8+X^5+1
PRBS13: X^13+X^12+X^10+X^9+1
PRBS14: X^14+X^13+X^10+X^9+1
PRBS15: X^15+X^14+1
PRBS23: X^23+X^18+1
Note: The pattern length of the PRBS23 is 8388608--1. In DTG5078,
pattern data is created only up to 8,000,000 vectors for restriction of
data length.

Mark Density PRBSn is a random pattern of 0s and 1s whose pattern cycle period
is 2n--1 (n = number of registers. In above Pattern, n = 5 to 23).
Mark Density varies the percentage of 1s (= marks) in the cycle.

Suppose that the pattern obtained by Left Rotating n patterns of
PRBSn patterns (it shifts to the left by n piece, and a part to have
overflowed is attached to the tail end) is PRBSnn and the pattern
obtained by Left Rotating 2n patterns of PRBSn patterns is
PRBSn2n. If PRBSn is ANDed with PRBSnn or PRBSn2n, this
decreases the percentage of 1s. If it is ORed with them, this
increases the percentage. Mark Density accepts 1/8 to 7/8. The
following expressions are used to obtain the value:

1/8: PRBSn & PRBSnn & PRBSn2n
1/4: PRBSn & PRBSnn
1/2: PRBSn
3/4: PRBSn | PRBSnn
7/8: PRBSn | PRBSnn | PRBSn2n
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Table 1--4: PRBS/PRWS dialog box settings (cont.)

Items Description

Invert Inverts the values of 0s and 1s of the resulting random pattern.

Setting Invert to Off generates a pattern that results from inversion of
the PRBSn 0/1 pattern obtained by calculation.
Setting Inversion to On generates the PRBSn pattern obtained by
calculation.

Copies the pattern data from the specified range to the Windows clipboard. Copy
and Paste with the Windows clipboard manipulate the pattern data as text data.

Pastes the contents of the Windows clipboard to the location starting form the
cursor position. This command places the cursor at the top left corner of the
rectangle, i.e., at the MSB, or the position of the least vector number.

You can import to the DTG5000 software a pattern file created with other
equipment or another application. The Import command, included in the File
menu, is available while the Data--Listing or Data--Waveform windows is open.
The Import command supports files of the following formats:

� Tektronix TLA Data Exchange Format (*.txt)

� Tektronix HFS Vector Files (ASCII) (*.vca)

� Tektronix HFS Vector Files (Binary) (*.vcb)

Import of the data is achieved block by block. The contents of the whole of the
block you are editing are replaced with the data in the file imported. The vector
length of the block is defined as the length of the data imported.

TLA and HFS files have grouping information (group name and width--in--bits).
Data for several groups is included in a single TLA or HFS file.

When a group name is not defined or the same group names exists but the bit
width differs, DTG5000 software will reorganize its groups to match the groups
of the imported file. In these cases, all the assignments to the physical channels
are reset.

If the groups are not reorganized, the assignments to the physical channels
remain in the initial conditions.

Copy to Clipboard...

Paste from Clipboard...

Importing a pattern file
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Only one grouping applies to the whole system. Redefining a group influences
all the blocks other than the one you are editing. Although the vector lengths of
the other blocks and the data for the channels remain unchanged, the channel
information included may be changed as a result of change of the grouping.

The group names in the imported file are case--sensitive. Any group name
exceeding the DTG5000 software--supported group name length (32 characters)
causes an error. In addition to the group name, the radix option specified in the
file is used as the group’s radix option in the DTG5000 software.

A format that is used to replace data prepared in a TLA file. The following example
lists data for two groups: Addr and Data, both of which have 16 channels and a
vector length of 32. The example is followed by format description.

[vectors]
Sample[] Addr[15:0](Hex) Data[15:0](Hex) Timestamp[]
0 0000 0000 0
1 FFFF 0001 10.0000000 ns
2 0000 0002 10.0000000 ns
3 FFFF 0003 10.0000000 ns
4 0000 0004 10.0000000 ns
5 FFFF 0005 10.0000000 ns
6 0000 0006 10.0000000 ns
7 FFFF 0007 10.0000000 ns
8 0000 0008 10.0000000 ns
9 FFFF 0009 10.0000000 ns
10 0000 000A 10.0000000 ns
11 FFFF 000B 10.0000000 ns
12 0000 000C 10.0000000 ns
13 FFFF 000D 10.0000000 ns
14 0000 000E 10.0000000 ns
15 FFFF 000F 10.0000000 ns
16 0000 0010 10.0000000 ns
17 FFFF 0011 10.0000000 ns
18 0000 0012 10.0000000 ns
19 FFFF 0013 10.0000000 ns
20 0000 0014 10.0000000 ns
21 FFFF 0015 10.0000000 ns
22 0000 0016 10.0000000 ns
23 FFFF 0017 10.0000000 ns
24 0000 0018 10.0000000 ns
25 FFFF 0019 10.0000000 ns
26 0000 001A 10.0000000 ns
27 FFFF 001B 10.0000000 ns
28 0000 001C 10.0000000 ns
29 FFFF 001D 10.0000000 ns
30 0000 001E 10.0000000 ns
31 FFFF 001F 10.0000000 ns

Figure 1--20: TLA data exchange format example

TLA Data Exchange
Format
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Each file contains the header on two lines and one--vector data on a line.

Header.

[vectors]

Sample[] Addr[15:0](Hex) Data[15:0](Hex) Timestamp[]

� The first line starts with “[vectors]”.

� The second line starts with “Sample[]” and ends with “Timestamp[]”.

� This line includes the group definition.

� Items are Tab--separated.

� “[vectors]” of the 1st line, “Sample[]”and “Timestamp[]”of the 2nd line are
omissible. However, when “Sample[]” and “Timestamp[]” are omitted by the
2nd line, it is necessary to also delete corresponding data of the 3rd line. The
row (column position) of a group definition of the 2nd line and the row of
data of the 3rd or less line which were divided by Tab need to correspond to
1 to 1.

Group Definition.

Syntax: <group name>[MSB:LSB](Radix)

Example : Data[31:0](Hex)

Rules

� If channel information ( [(MSB):(LSB)] ) is missing, the data will not be
regarded as a group.
Example: Samples[], Timestamp[], Addr[](Hex), Addr(Hex) will not be
regarded as a group.

� If radix information exists although channel information is missing (like
Addr[ : ](Hex) ), the data will be regarded as a group with one channel.

� You can specify Binary, Octal, Decimal, or Hex for the radix option. Type
three characters “BIN”, “OCT”, “DEC” or “HEX” respectively. It is
case-insensitive.

� If you do not specify the radix option, Hex will be assumed.

� Data which is not assumed as a group data on the data line is skipped.

� Channels of group = MSB -- LSB + 1

� The offset value given by LSB is disregarded.
Example: Data[50:40](Hex) of group definition becomes Data[10:0](Hex).
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A set of the HFS pattern definition GPIB commands stored in a file. *.vca and
*.vcb are ASCII files whose data fields are represented in ASCII code and binary
notation, respectively. They contain the group names and radix and display order
information. The following is an example of a *.vca file:

:FPAN:VRADIX DEC

:PGENA:CH1:SIGNAL ”Data3”;CVIEW GROUP;DRADIX HEX

:PGENA:CH1:DATA 0,50,”00001010010101111001011101110000001110011101001001”
:PGENA:CH1:DATA 50,50,”11101011101010001001000011001110000101111011011001”

:PGENA:CH1:DATA 100,28,”1010000111011110000111111111”

:PGENA:CH2:SIGNAL ”Data2”;CVIEW GROUP;DRADIX HEX

:PGENA:CH2:DATA 0,50,”00011000110010100011010010111111101000101100011101”

:PGENA:CH2:DATA 50,50,”01100101100111100011111011101000001101011011011101”
:PGENA:CH2:DATA 100,28,”1000001011010111110101010100”

:PGENA:CH3:SIGNAL ”Data1”;CVIEW GROUP;DRADIX HEX

:PGENA:CH3:DATA 0,50,”00100001000110000100111001010101100001101111010011”

:PGENA:CH3:DATA 50,50,”01110010001010000101011010011111101100100100101101”

:PGENA:CH3:DATA 100,28,”1111100100110101001100110000”

:PGENA:CH4:SIGNAL ”Data0”;CVIEW GROUP;DRADIX HEX
:PGENA:CH4:DATA 0,50,”10000011110111110001011100110010000010010100111011”

:PGENA:CH4:DATA 50,50,”01000111100111110011011000101010010001110001101101”

:PGENA:CH4:DATA 100,28,”0101110001001100010001000000”

:PGENB:CH1:SIGNAL ”Addr0”;CVIEW GROUP;DRADIX HEX

:PGENB:CH1:DATA 0,50,”00000000111111110000000011111111000000001111111100”
:PGENB:CH1:DATA 50,50,”00000011111111000000001111111100000000111111110000”

:PGENB:CH1:DATA 100,28,”0000111111110000000011111111”

:PGENB:CH2:SIGNAL ”Addr1”;CVIEW GROUP;DRADIX HEX

:PGENB:CH2:DATA 0,50,”00001111000011110000111100001111000011110000111100”

:PGENB:CH2:DATA 50,50,”00111100001111000011110000111100001111000011110000”
:PGENB:CH2:DATA 100,28,”1111000011110000111100001111”

:PGENB:CH3:SIGNAL ”Addr2”;CVIEW GROUP;DRADIX HEX

:PGENB:CH3:DATA 0,50,”00110011001100110011001100110011001100110011001100”

:PGENB:CH3:DATA 50,50,”11001100110011001100110011001100110011001100110011”

:PGENB:CH3:DATA 100,28,”0011001100110011001100110011”

:PGENB:CH4:SIGNAL ”Addr3”;CVIEW GROUP;DRADIX HEX
:PGENB:CH4:DATA 0,50,”01010101010101010101010101010101010101010101010101”

:PGENB:CH4:DATA 50,50,”01010101010101010101010101010101010101010101010101”

:PGENB:CH4:DATA 100,28,”0101010101010101010101010101”

:FPAN:SORDER ”Data3”,”Data2”,”Data1”,”Data0”,”Addr0”,”Addr1”,”Addr2”,”Addr3”

Figure 1--21: HFS vector file (*.vca) example

The group names, the number of channels, and the display order are determined

by the SORDER command on the last line. The above example defines a block

that consists of two groups. One is Data, which has four channels and has Data3

and Data0 as the MSB and LSB, respectively. The other is Addr, which has four
channels and has Addr0 and Addr3 as the MSB and LSB, respectively. In the

example, channel assignments and view and radix information are specified

using the SIGNAL commands, but the DTG5000 software imports only radix

information. DATA commands are used to specify the pattern data. In the

HFS Vector Files
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example, the data for a total of 128 vectors (50 vectors beginning at vector
number 0, 50 vectors beginning at vector number 50, and 28 vectors beginning

at vector number 100) is set for each of the channels.

*.vcb files differ from *.vca files in the commands. They use BDATA command to
specify the binary encoded pattern data.

Refer to the “DTG5000 Series Programmer Manual” for details, such as the
BDATA commands.
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Timing Parameters

This section provides information about the timebase--related items. To set the
timing parameters, use the Timing window.

Figure 1--22: Timing window (Data Generator mode)
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Data Format

For the output data format, you can select NRZ (Non Return to Zero), RZ
(Return to Zero), or R1 (Return to One) for each of the channels. For the
channels of Slots A to D, you can select from among three formats. For the
DTG5078, the channels of Slots E to H, you can only use NRZ.

Data pattern

NRZ

R1

RZ

001 1 1

Figure 1--23: Data format

For RZ, Data 1 is output as ’10’. Similarly, for R1, Data 0 is output as ’01’. To
enable this, one set of data is represented using two sets of data; the clock
frequency is doubled for output. For example, if a 10 MHz RZ pattern of ’10’
with a vector length of 2 is output, Data 1000 with a vector length of 4 is created
internally before being output with a 20 MHz clock frequency. For this reason,
the maximum clock frequency of a pattern including RZ or R1 in the data format
is half the maximum clock frequency that each of the models has. The maximum
frequency is actually 375 MHz for DTG5078 or 1.35 GHz for DTG5274.
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Clock Source

To select the clock source, use the Time Base window. You have the four options
listed in Table 2--5. If you use the External PLL or Clock Input signal, the
DTG5000 software measures the frequency of the connected signal and displays
the measured values in the Timing window. Figure 1--25 on page 1--38 shows the
internal connections of each clock source.

Figure 1--24: Clock Source in Time Base window

Table 1--5: Clock source

Clock Source Description

Internal Generates the clock signal with the programmable oscillator that
contains the DDS, PLL, and VCO circuits based on the 10 MHz
internal reference clock.

External 10MHz Refer-
ence

Generates the clock signal using the external reference signal
instead of the 10 MHz internal reference clock.

You can use the following signals: Frequency range 10¦ 0.1 MHz,
Input voltage swing 0.2 to 3 Vp--p, Maximum input voltage¦ 10 V,
Impedance 50 Ω, and AC coupled.

If you use the 10 MHz external reference signal, the valid clock
frequency range and step size you can set are the same as when
you use Internal for the clock source.
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Table 1--5: Clock source (cont.)

Clock Source Description

External PLL Input Specifies that the external signal connected to PHASE LOCK IN is
used as the input signal to the PLL circuit.

You can use the following signals: Frequency range 1 to 200 MHz,
Input voltage swing 0.2 to 3 Vp--p, Maximum input voltage¦ 10 V,
Impedance 50 Ω, and AC coupled.

When you use the External PLL Input signal, the DTG5000 software
measures the frequency of the input signal and shows the result in
PLL Input: in the Timing window. The output frequency basically
varies in steps of the amount that is n times larger than the
frequency of the External PLL Input signal. The step size varies,
depending on the data format and Long Delay On/Off setting.

External Clock Input Specifies that the external clock signal is fully used as the clock
signal.

You can use the following signals: Frequency range 1 to 750 MHz for
DTG5078 (1 MHz to 2.7 GHz for DTG5274), Input voltage swing 0.2
to 2 Vp--p, Duty cycle 50¦ 10%, Impedance 50 Ω, and AC
coupled.
When you use the External Clock Input signal, the DTG5000
software measures the frequency of the input signal and shows the
result in Clock Input: in the Timing window. The output frequency is
basically fixed to the frequency of the External Clock Input signal.
However, it varies, depending on the data format or Long Delay
On/Off setting.

DDS

PLL

Ext 10MHz Ref In

Divider

Ext PLL In

Internal

10MHz Ref

Ext Clock In

H/W Clock

Figure 1--25: Selecting a clock source
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The DTG5000 software sometimes prompts you to confirm that you are saving
the current settings. You see it when you attempt to load the settings file or to
change the mode from Data Generator to Pulse Generator, after having modified
the internal settings. If you are currently using an External PLL or External
Clock Input signal as the clock source, the timing parameters in the DTG5000
software change when the external clock source state changes. This occurs even
if you have not modified the settings. For this reason, even if you have not
modified the settings, you may be prompted to confirm that you are saving the
settings

Valid Frequency Range and Step Size

Tables 1--6 and 1--37 summarize the valid setting ranges of clock frequencies,
which depend on the clock source, data format, and Long Delay On/Off setting.

Table 1--6: Valid frequency range and step size by clock source (Data Generator mode)

Clock Source Internal Ext 10 MHz Ref Input Ext PLL Input Ext Clock

External signal
frequency range

none 10 MHz¦ 0.1 MHz Fextpll = 1 MHz to
200 MHz

Fextcl =1 MHz to 750 MHz
(DTG5078)

Fextcl =1 MHz to 2.7 GHz
(DTG5274)

Long Delay OFF

Clock Frequency
range

NRZ only:
50 kHz to 750 MHz
includes RZ or R1:
50 kHz to 375 MHz
(DTG5078)

NRZ only:
50 kHz to 2.7 GHz
includes RZ or R1:
50 kHz to 1.35 GHz
(DTG5274)

NRZ only:
50 kHz to 750 MHz
includes RZ or R1:
50 kHz to 375 MHz
(DTG5078)

NRZ only:
50 kHz to 2.7 GHz
includes RZ or R1:
50 kHz to 1.35 GHz
(DTG5274)

NRZ only:
Fextpll to 750 MHz
includes RZ or R1:
Fextpll / 2 to 375 MHz
(DTG5078)

NRZ only:
Fextpll to 2.7 GHz
includes RZ or R1:
Fextpll / 2 to 1.35 GHz
(DTG5274)

NRZ only:
Fextcl
includes RZ or R1:
Fextcl / 2
(DTG5078)

NRZ only:
Fextcl
includes RZ or R1:
Fextcl / 2
(DTG5274)

Frequency step 8 digit 8 digit Fextpll / Vector Rate 0 (fixed)
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Table 1--6: Valid frequency range and step size by clock source (Data Generator mode) (cont.)

Clock Source Ext ClockExt PLL InputExt 10 MHz Ref InputInternal

Long Delay ON

Clock Frequency
range

NRZ only:
50 kHz to 750 MHz
includes RZ or R1:
50 kHz to 375 MHz
(DTG5078)

NRZ only:
50 kHz to 2.7 GHz
includes RZ or R1:
50 kHz to 1.35 GHz
(DTG5274)

NRZ only:
50 kHz to 750 MHz
includes RZ or R1:
50 kHz to 375 MHz
(DTG5078)

NRZ only:
50 kHz to 2.7 GHz
includes RZ or R1:
50 kHz to 1.35 GHz
(DTG5274)

NRZ only:
50 kHz <
Fextpll × N / Vector Rate
< 750 MHz
includes RZ or R1:
50 kHz <
Fextpll × N / Vector Rate
< 375 MHz
(DTG5274)

NRZ only:
50 kHz <
Fextpll × N / Vector Rate
< 2.7 GHz
includes RZ or R1:
50 kHz <
Fextpll × N / Vector Rate
< 1.35 GHz
(DTG5274)

NRZ only:
Fextcl / Vector Rate
includes RZ or R1:
Fextcl / Vector Rate
(DTG5078)

NRZ only:
Fextcl / Vector Rate
includes RZ or R1:
Fextcl / Vector Rate
(DTG5274)

Frequency step Fextpll / Vector Rate 0 (fixed)

Table 1--7: Valid frequency range and step size by clock source (Pulse Generator mode)

Clock Source Internal Ext PLL Input Ext Clock

External signal
frequency range

none 10MHz¦ 0.1MHz Fextpll = 1MHz to 200MHz Fextcl =1MHz to 750MHz
(DTG5078)

Fextcl =1MHz to 2.7GHz
(DTG5274)

Clock Frequency
range

50kHz to 375MHz
(DTG5078)

50kHz to 1.35GHz
(DTG5078)

50kHz to 375MHz
(DTG5078)

50kHz to 1.35GHz
(DTG5078)

50kHz <
Fextpll × N / Vector Rate
< 375MHz
(DTG5078)

50kHz <
Fextpll × N / Vector Rate
< 1.35GHz
(DTG5078)

Fextcl / Vector Rate
(DTG5078)

Fextcl / Vector Rate
(DTG5078)

Frequency step Fextpll / Vector Rate 0 (fixed)
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If you use either External Clock or External PLL Input, the user--defined clock
frequency setting is restricted as below, depending on the frequency of the
external input signal, use of Long Delay, and the data format condition.

Table 1--8, “Restrictions on using External Clock Input” on page 1--41 summa-
rizes the restrictions that arise when you select External Clock Input for the clock
source. Table 1--9, “ Restrictions on using External PLL Input” on page 1--42
summarizes the restrictions that arise when you select External PLL Input.

Table 1--8: Restrictions on using External Clock Input

External Clock
Frequency

Data Generator mode
Long Delay ON

Data Generator mode
Long Delay OFF

Pulse Generator mode
q y

NRZ only includes RZ or R1

Fextcl <
400 MHz

Error. (The sequence cannot start.) As an external clock sig-
nal, you can input the
signal of the frequency
range of following Fextcl.

Error. (The sequence can-
not start.)

400 MHz�
Fextcl
� 800 MHz

You can change the clock range. The vector rate is
uniquely determined according to the change of the
clock range, resulting in a fixed clock frequency of Fextcl
/ Vector Rate.

range of following Fextcl.

Fextcl =1 MHz to 750 MHz
(DTG5078)
Fextcl =1 MHz to 2.7 GHz
(DTG5274)

The clock frequency is
fixed to
Fextcl (NRZ only), or
Fextcl / 2 (includes RZ or

You can not select the
clock range, but DTG5000
selects it automatically.
The vector rate is uniquely
determined according to
the change of the clock
range, resulting in a fixed
clock frequency of Fextcl /
VectorRate.

800 MHz <
Fextcl

The clock range is fixed to
400 MHz or more. The
vector rate is 1, while the
clock frequency is fixed to
Fextcl.

The clock range is fixed to
200 MHz or more. The
vector rate is 2, while the
clock frequency is fixed to
Fextcl / 2.

/ (
R1)
according to the Fextcl.

The internal clock range is
fixed to 200 MHz or more.
The vector rate is 2, while
the clock frequency is fixed
to Fextcl / 2.

Restrictions on using
External Clock and PLL

Input
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Table 1--9: Restrictions on using External PLL Input

Data Generator mode
Long Delay OFF

Data Generator mode
Long Delay OFF

Pulse Generator mode

NRZ only includes RZ or R1

For the user--defined clock frequen-
cy, you can change the setting only
within the clock range.

Changing the user--defined clock
frequency does not cause automatic
change of the clock range.

You can set the user--defined clock
frequency to [Fextpll (input frequency
of External PLL In)× N / vector
rate].

You can set the user--de-
fined clock frequency to
[Fextpll (input frequency of
External PLL In)× N].

You can set the user--de-
fined clock frequency to
[Fextpll (input frequency of
External PLL In)× N / 2].

You can set the user--defined clock
frequency to [Fextpll (input frequency
of External PLL In)× N].

There is the following relationship between the user--defined clock frequency
(displayed in Frequency in the Timing window) and the hardware clock
frequency (i.e., the clock frequency in the DTG5000 Series Data Timing
Generator ):

User--defined clock frequency = Hardware clock frequency / vector rate

Hardware clock frequency = Fextpll × PLL_Multiplier Rate

User--defined clock frequency = Fextpll × n
= Fextpll × n× vector rate / vector rate
= Fextpll × PLL_Multiplier Rate / vector rate
= Hardware clock frequency / vector rate
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Vector Rate

When outputting pattern data of a given vector length with a given frequency, the
DTG5000 software enlarges the vector length of the pattern data internally by a
factor of an integral multiple. In proportion to the resulting vector length, it may
output the signal of the given frequency with the clock frequency increased.
(This is detailed in the “Data Format” section.) Output of R1 or RZ and the Long
Delay feature are obtained in this way.

The ratio between the vector length (in the pattern memory) in the DTG5000
software and that of the pattern data is called the vector rate. If we turn our
attention to the frequency, we can define it also as the ratio between the clock
frequency in the hardware and the user--defined frequency.

The vector rate is displayed in the Timing window (see Figure 1--26). Whatever
the Clock Source you specify, it remains on--screen. If Long Delay is off and
neither RZ nor R1 exists, the vector rate will be always ×1. If Long Delay is off
and RZ or R1 exists, it will be ×2. If Long Delay is on, the rate will change
from ×1, 2, 4, 8, 10, 20, and so on to 8000. The vector rate helps you to get
information including the utilization of the pattern memory in the DTG5000
software, the internal operating frequency, and the clock frequency output from
Clock Out.
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PLL Clock Multiple Rate

The PLL clock multiple rate is the HW clock frequency divided by the External
PLL Input frequency in the DTG5000 Series Data Timing Generator. This value
is displayed in the form of ’×n’ after the input frequency, only if Clock Source
is External PLL Input.

Vector Rate PLL Clock Multiple Rate

Figure 1--26: PLL Clock Multiple Rate

Figure 1--27 shows the relationship among the user--defined frequency (Clock
Frequency), the External PLL Input frequency, the clock frequency in the
hardware, and the Clock Out frequency. This relationship depends on the PLL
Clock Multiple Rate and the vector rate.

External PLL Input

200 MHz

PLL Clock Multipule Rate x 2

H/W Clock

400 MHz

Vector Rate = 8

Frequency

50 MHz

Clock Out

400 MHz

Figure 1--27: Rates and Frequencies
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Definition of Pulse Parameters

The DTG5000 software defines the parameters of the output pulse as shown
below.

RZ, R1 and Pulse Generator
Period

Period

Trail Delay

Lead Delay Pulse Width

Duty = Pulse Width / Period x 100 (%)

Phase = Lead Delay / Period x 100 (%)

NRZ

Lead Delay

Phase = Lead Delay / Period x 100 (%)

Figure 1--28: Definition of Pulse parameters

You must set the pulse parameters for each of the channels.

For the Delay parameter, you can select either Lead Delay (s) or Phase (%). You
can set it to even a value larger than Period.

For Width, you can select Duty (%), Pulse Width (s), or Trail Delay (s).

Table 1--10: Pulse parameters

RZ, R1 and Pulse Generator mode NRZ

Delay Lead Delay (s)

Phase = Lead Delay / (Period x Pulse
Rate) x 100 (%)

Lead Delay (s)

Phase = Lead Delay / (Period x Pulse
Rate) x 100 (%)

Width Duty (%)

Pulse Width (s)

Trail Delay (s)

none
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Delay Offset

This feature shifts the Delay setting reference point of the entire system. By
default (Delay Offset = 0 s), you can set only a positive value for the delay of
any channel relative to 0 s. This feature allows you to set a negative value as
well by shifting the whole delay settings apparently. The valid ranges are
summarized in the table below.

You can set the value in steps of 0.2 ps for DTG5274 or 1 ps for DTG5078.

Table 1--11: Valid ranges of Delay Offset

Operation
Mode

Long Delay Format Period Delay Offset

Data
G t

Off 0 to H/W Maximum Delay1

Generator
On NRZ only � 1.25 ns S/W Sequence: 0 to 600 ns

H/W Sequence: 0 to 300 ns

� 1.25 ns S/W Sequence:
0 to 480 x Period
H/W Sequence:
0 to 240 x Period

includes RZ or
R1

� 2.5 ns S/W Sequencer: 0 to 600 ns
H/W Sequencer: 0 to 300 ns

� 2.5 ns S/W Sequence:
0 to 240 x Period
H/W Sequence:
0 to 120 x Period

Pulse
Generator

0 to 3 �s

1. H/W Maximum Delay = 5 ns

Figure 1--29 shows a graph indicating the valid ranges that apply if Long Delay
is on in the Data Generator mode. When Delay Offset is 0, it shows the same
valid ranges of Lead Delay.
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contains RZ or R1

NRZ only

600 ns

177.7 ns

(300 ns)

400 M 800 M 1.35 G 2.7 G

Data Rate (h/s)

M
axim

um
Lead

D
elay

the numbers in ( ) are for H/W Sequence

(88.88 ns)

Figure 1--29: Definition of Pulse parameters
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Valid Ranges of Pulse Parameters

The pulse pattern is determined by combination of multiple pulse parameters.
This section summarizes the valid ranges of the Lead Delay and Trail Delay
parameters.

Like Delay Offset, you can set the Lead Delay in steps of 0.2ps for DTG5274 or
1ps for DTG5078.

Table 1--12: Valid ranges of Lead Delay

Operation
Mode

Long Delay Format Period Lead Delay

Data
Generator

Off 0 (-- Delay Offset) to H/W maximum delay1 (--
Delay Offset)

On NRZ only � 1.25
ns

S/W Sequence:
0 (-- Delay Offset) to 600 ns (-- Delay Offset)
H/W Sequence:
0 (-- Delay Offset) to 300 ns (-- Delay Offset)

� 1.25
ns

S/W Sequence: 0 (-- Delay Offset) to 480 x
Period (-- Delay Offset)
H/W Sequence: 0 (-- Delay Offset) to 240 x
Period (-- Delay Offset)

includes RZ or R1 � 2.5 ns S/W Sequence:
0 (-- Delay Offset) to 600 ns (-- Delay Offset)
H/W Sequence:
0 (-- Delay Offset) to 300 ns (-- Delay Offset)

� 2.5 ns S/W Sequence: 0 (-- Delay Offset) to 240 x
Period (-- Delay Offset)
H/W Sequence: 0 (-- Delay Offset) to 120 x
Period (-- Delay Offset)

Pulse
Generator

� 3 �s 0 (-- Delay Offset) to Period (--Delay Offset)
Generator

� 3 �s 0 (-- Delay Offset) to 3 �s (-- Delay Offset)

1. H/W maximum delay = 5 ns

To set the Lead Delay (s), you can also use Phase (%). You can use the following
expression to obtain the phase setting value based on the setting range of Lead
Delay. You can set the value in steps of 0.1%.

Phase = Lead Delay / (Period×Pulse Rate)×100 (%)

Pulse Rate : 20 to 24 (Pulse Generator mode)
1 (Data Generator mode)

Lead Delay

Phase
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Operations.
To specify the pulse change position, you can select Delay or Phase. If you want
to use Phase, move the cursor over the Delay column. Next, press the SELECT
key to open the pop--up menu. Alternatively, press theMENU key to open the
Edit menu. Then, select Phase from the menu.

You can set Trail Delay in steps of 5 ps.

Table 1--13: Valid ranges of Trail Delay

Operation
Mode

Long Delay Period Trail Delay

Data
Generator

Off � H/W maxi-
mum delay x 2

If Jitter Generator is on and the channel has been assigned
to Slot A CH1 of the mainframe:
Minimum Pulse Width (--Delay Offset) to H/W Maximum
Delay + Minimum Pulse Width (--Delay Offset)

Otherwise:
Minimum Pulse Width (--Delay Offset) to H/W Maximum
Delay + Period / 2 (--Delay Offset)

The value converted into Duty must be 0% to 100%. In
addition, the pulse width must be in the range from ’Minimum
Pulse Width’ to ’Period -- Minimum Pulse Width.’

� H/W maxi-
mum delay x 2

Period / 2 (--Delay Offset) to
H/W Maximum Delay + Period / 2 (--Delay Offset)

The value converted into Duty must be 0% to 100%. In
addition, the pulse width must be in the range from ’Minimum
Pulse Width’ to ’Period -- Minimum Pulse Width.’

Data
Generator

On The value converted into Duty must be 0% to 100%. In
addition, the pulse width must be in the range from ’Minimum
Pulse Width’ to ’Period -- Minimum Pulse Width.’

Pulse
Generator

� 3 �s The value converted into Duty must be 0% to 100%. In
addition, the pulse width must be in the range from ’Minimum
Pulse Width’ to ’Period x Pulse Rate -- Minimum Pulse
Width.’

Minimum Pulse Width = 290 ps
H/W maximum delay = 5 ns

Trail Delay
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You can use the following expression to obtain the valid range of Duty based on
the Trail Delay setting range. You can set the value in steps of 0.1%.

Duty = (Trail Delay -- Lead Delay) / (Period × Pulse Rate) ×100(%)

Pulse Rate : 20 to 24 (Pulse Generator mode)
1 (Data Generator mode)

Operation.
You can set the Duty when the Format is either RZ or R1. To specify the pulse
width, you can select either Duty or Pulse Width. If you want to use Duty, move
the cursor over the PW/Duty/Cross Point column. Next, press the SELECT key
to open the pop--up menu. Alternatively, press theMENU key to open the Edit
menu. Then, select Duty from the menu.

If you use Duty for setting, the value will be prefixed with letter ’D’.

You can use the following expression to obtain the valid range of pulse width
from the setting range of Trail Delay or Duty. You can set the value in steps of
the same size as for Trail Delay.

Pulse Width = Duty× (Period × Pulse Rate) / 100 = Trail Delay -- Lead Delay

Pulse Rate : 20 to 24 (Pulse Generator mode)
1 (Data Generator mode)

Operation.
You can set the Pulse Width when the Format is either RZ or R1. To specify the
pulse width, you can select either Duty or Pulse Width. If you want to use Pulse
Width, move the cursor over the PW/Duty/Cross Point column. Next, press the
SELECT key to open the pop--up menu. Alternatively, press theMENU key to
open the Edit menu. Then, select Pulse Width from the menu.

If you use Pulse Width for the setting, the value will be prefixed with letter ’W’.

Duty

Pulse Width
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Slew Rate

Slew Rate indicates the pulse responsiveness (rise and fall times) by showing the
variation in output voltage per nanosecond (V/ns). Larger the value, shorter the
pulse rise or fall times.

Slew Rate

SmallLarge

Figure 1--30: Slew Rate

For the Slew Rate setting, there are no differences that depend on the mainframe
or slot position. However, you can find slight differences in the settings or other
conditions, depending on the output module currently installed in the slot. Table
2--14, “ Slew Rate control” summarizes the differences.

� You can change Slew Rate before output only for the DTGM10 and
DTGM20 output module channels.

� The slopes vary simultaneously by the same amount relative to both the
rising and falling edges.

� The amplitude of the output signal may not reach the setting, depending on
the Slew Rate, pulse width, and/or amplitude settings.

� Varying Slew Rate shifts the 50% position of the amplitude. When Slew
Rate is at the maximum level, Delay and Width are calculated at the 50%
position of the amplitude before being output. This produces a difference
between the setting and the value obtained from the actual output signal.

Table 1--14: Slew Rate control

DTGM10 DTGM20 DTGM30

Range 0.65 V/ns to 1.30 V/ns
into 50 Ω to GND

0.63 V/ns to 2.25 V/ns
into 50 Ω to GND

fixed

Resolution 0.01 V/ns 0.01 V/ns
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Cross Point Control

This feature moves up or down the cross point of the rising and falling lines,
which is displayed in the eye pattern of the output signal. To achieve this, the
feature adjusts the rising and falling edge delay positions of data format NRZ.
Set the cross point position (%) relative to the amplitude. The low level position
is 0%, the middle 50%, and the high level position 100%. If you make the rising
edge later and make the falling edge earlier, the cross point will be lowered.

� This feature is available only in the Data Generator mode on the DTGM30
output module installed in Slots A to D. This feature is not available in the
Pulse Generator mode.

� You can set the value in steps of 5% in the 30% to 70% range.

By adjusting the Rise Delay and Fall Delay,

the Cross Point varies.

70%

30%

Figure 1--31: Cross Point control

Table 1--15: Cross Point control

DTGM10 DTGM20 DTGM30

Range Not available Not available 30 % to 70 %

Resolution Not available Not available 2 %
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Operation.
You can set up Cross Point only in a PW/Duty/Cross Point cell for either of the
following channels:

� A channel has not been assigned and its format is NRZ, or

� A channel of the DTGM30 installed in Slots A to D has been assigned and
its format is NRZ.

If you use Cross Point for setting, the value will be prefixed with letter “C”.

Long Delay

For each of Delay and Pulse Width, the variable range supported by DTG5000
Series hardware is only approximately 5 ns. For more amounts of Delay and
Pulse Width, 480 ns is enabled at the maximum by internally manipulating the
data pattern by software.

Long Delay writes the pattern into the pattern memory while displacing it by
software.

User--defined pattern

When a clock frequency is 100MHz

Contents of pattern memory

10ns

0 1 0 0 1 1 0 0

0 0 1 0 0 1 1 0

Figure 1--32: Writing the pattern into the memory while displacing it

Displacement of the pattern allows you to set the value only with an integral
multiple of the clock frequency. Therefore, the section under the clock frequency
is required to be delayed by hardware delay.

If the clock frequency is later than the valid range of hardware delay, you cannot
set the Delay value in a certain range. To avoid this problem, the software
enlarges the pattern.

For example, if you want to output a “010” pattern with a clock frequency of 200
MHz, you cannot set the Delay to 9 ns. This is because the hardware delay can
be up to 5 ns. In this case, the software writes a double--length enlarged pattern
internally into the pattern memory to operate the clock at the double rate.
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0 1 0

5ns 2.5ns 5ns

0 0 1 1 0 0

User--defined clock period = 5 ns

Hardware clock period = 2.5 nsHardware clock period = 5 ns

User--defined clock period = 5 ns

When a clock frequency is 100MHz

Figure 1--33: Enlarging the clock pattern and speeding up the hardware clock

Then the pattern is displaced backward by three patterns so that the hardware
delay is 1.5 ns. This causes a delay of 9 ns.

User--defined clock period = 5 ns

Hardware clock period = 2.5 ns

This causes a total delay of 9 ns.

Three patterns shift produces a delay of 7.5 ns; the hardware delay produces a delay of 1.5 ns.

1.5ns

2.5 x 3 = 7.5ns

0 0 1 1 0 0

0 0 1 1 0 0

0 0 1 1 0 0

Figure 1--34: Obtaining a long delay

The Data Generator mode allows you to toggle Long Delay on or off in the
Timing window. In the Pulse Generator mode, Long Delay is always enabled
internally. Therefore it does not have a Long Delay On or Off setting.

Table 1--24 summarizes the characteristics of Long Delay.
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Table 1--16: Characteristics of Long Delay

Long Delay Off Long Delay On

Changing the
delay and pulse
width

By hardware By hardware and software

Valid ranges of
delay and pulse
width

Small Large

Pattern memory
usage

Fixed

Vector length itself if the pattern
contains only NRZ.

Double length of the vector, if the
pattern includes RZ or R1.

Increases in proportion to the vector
rate. (The lower the user--defined
frequency, the higher the vector
rate.)

If the program includes Jump, Goto,
or Wait, the memory usage in-
creases correspondingly.

Sequence
memory usage

Sequence definition itself If the program includes Jump, Goto,
or Wait, the memory usage in-
creases correspondingly.

Command jump/
Event jump

Available Not available

Wait, Goto, Inf.,
subsequence

Available Available

In any section in which the output clock frequency (i.e., user--defined clock
frequency) is slow, the data is enlarged by a factor of the vector rate according to
the output clock frequency. In addition, the internal hardware clock frequency is
increased to cause a long delay. As described here, the factor for enlarging the
data and that for increasing the internal clock frequency are determined
according to the output frequency. Therefore, before using Long Delay, you must
specify the output clock frequency value in the Clock Range.

Clock Range is displayed and available if Long Delay is on in the Data
Generator mode.

Tables 1--17 and 1--18 summarize the relationship among the Clock Range
settings, the vector rate and hardware frequency.

Clock Range
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Table 1--17: Clock Range if the pattern contains only NRZ

User--defined clock
frequency

User--defined
period

Hardware
clock fre-
quency

Vector Rate Minimum number of
blocks during hard-
ware sequence
(DTG5274 / DTG5078)

Restrictions on multi-
ple during hardware
sequence
(DTG5274 / DTG5078)

from to from to

>400 MHz <2.5 ns >400 MHz 1 960 / 240 4 / 1

400 MHz 200 MHz 2.5 ns 5 ns 800 MHz to
400 MH

2 480 / 120 2 / 1

200 MHz 100 MHz 5 ns 10 ns
400 MHz

4 240 / 60 1 / 1

100 MHz 50 MHz 10 ns 20 ns 8 120 / 30

50 MHz 25 MHz 20 ns 40 ns 16 60 / 15

40 MHz 20 MHz 25 ns 50 ns 20 48 / 12

20 MHz 10 MHz 50 ns 100 ns 40 24 / 6

10 MHz 5 MHz 100 ns 200 ns 80 12 / 3

5 MHz 2.5 MHz 200 ns 400 ns 160 6 / 2

4 MHz 2 MHz 250 ns 500 ns 200 5 / 2

2 MHz 1 MHz 500 ns 1 �s 400 3 / 1

1 MHz 500 kHz 1 �s 2 �s 800 2 / 1

500 kHz 250 kHz 2 �s 4 �s 1600 1 / 1

400 kHz 200 kHz 2.5 �s 5 �s 2000 1 / 1

200 kHz 100 kHz 5 �s 10 �s 4000

100 kHz 50 kHz 10 �s 20 �s 8000



Timing Parameters

DTG5078 & DTG5274 Data Timing Generator User Manual 1--57

Table 1--18: Clock Range if the pattern includes RZ or R1

User--defined clock
frequency

User--defined
period

Hardware
clock fre-
quency

Vector Rate Minimum number of
blocks during hard-
ware sequence
(DTG5274 / DTG5078)

Restrictions on multi-
ple during hardware
sequence
(DTG5274 / DTG5078)

from to from to

>200 MHz <5ns >200 MHz 2 480 / 120 2 / 1

200 MHz 100 MHz 5 ns 10 ns 800 MHz to
400 MH

4 240 / 60 1 / 1

100 MHz 50 MHz 10 ns 20 ns
400 MHz

8 120 / 30

50 MHz 25 MHz 20 ns 40 ns 16 60 / 15

40 MHz 20 MHz 25 ns 50 ns 20 48 / 12

22 MHz 10 MHz 50 ns 100 ns 40 24 / 6

10MHz 5 MHz 100 ns 200 ns 80 12 / 3

5 MHz 2.5 MHz 200 ns 400 ns 160 6 / 2

4 MHz 2 MHz 250 ns 500 ns 200 5 / 2

2 MHz 1 MHz 500 ns 1 �s 400 3 / 1

1 MHz 500 kHz 1 �s 2 �s 800 2 / 1

500 kHz 250 kHz 2 �s 4 �s 1600 1 / 1

400 kHz 200 kHz 2.5 �s 5 �s 2000

200 kHz 100 kHz 5 �s 10 �s 4000

100 kHz 50 kHz 10 �s 20 �s 8000

Clock Range is not available in Pulse Generator mode. If the Clock Source is
either Internal or External 10 MHz Reference in the Pulse Generator mode, the
internal clock range and vector rate are determined automatically according to
the user--defined frequency. For details, refer to the Table 1--19.

If the frequency is just at a boundary in the table below, the settings in the higher
range of the hardware clock frequencies are applied.
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Table 1--19: Clock Range used internally in Pulse Generator mode

User--defined clock
frequency

User--defined
period

Hardware
clock fre-
quency

Vector Rate Minimum number of
blocks during hard-
ware sequence
(DTG5274 / DTG5078)

Restrictions on multi-
ple during hardware
sequence
(DTG5274 / DTG5078)

from to from to

>200 MHz <5ns >200 MHz 2 480 / 120 2 / 1

200 MHz 100 MHz 5 ns 10 ns 800 MHz to
400 MH

4 240 / 60 1 / 1

100 MHz 50 MHz 10 ns 20 ns
400 MHz

8 120 / 30

50 MHz 25 MHz 20 ns 40 ns 16 60 / 15

40 MHz 20 MHz 25 ns 50 ns 20 48 / 12

22 MHz 10 MHz 50 ns 100 ns 40 24 / 6

10MHz 5 MHz 100 ns 200 ns 80 12 / 3

5 MHz 2.5 MHz 200 ns 400 ns 160 6 / 2

4 MHz 2 MHz 250 ns 500 ns 200 5 / 2

2 MHz 1 MHz 500 ns 1 �s 400 3 / 1

1 MHz 500 kHz 1 �s 2 �s 800 2 / 1

500 kHz 250 kHz 2 �s 4 �s 1600 1 / 1

400 kHz 200 kHz 2.5 �s 5 �s 2000

200 kHz 100 kHz 5 �s 10 �s 4000

100 kHz 50 kHz 10 �s 20 �s 8000
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Differential Timing Offset (DTO)

This feature outputs two types of patterns. One is a pattern for a logical channel.
The other is the inverted pattern that is obtained by displacing the rising and
falling edges in the same direction in time. To do this, the feature uses two
adjacent channels that have an odd and an even channel number, respectively.

Differential output Shift

Figure 1--35: Differential Timing Offset

At the inverted output, the rising and falling edges shift in the same direction.
You can set the amount of shift in the --1.0 to 1.0 ns range. It must meet both of
two conditions:

� Lead Delay + DTO� maximum Lead Delay, and

� Trail Delay + DTO� maximum Trail Delay.

If you set a positive value for the amount of shift, the pattern will shift so that
the signal at the inverted output will delay. You can set the value in steps of 1 ps
for DTG5078 or 0.2 ps for DTG5274.

You can set up the DTO feature independently of the mainframe, the currently
installed modules, and the slots. Note the following, however:

� To turn on or off the DTO feature or set its Offset value, use the Diff. Timing
Offset cell in the Timing window. Since the settings in this window are for
the logical channels rather than the physical channels, the channel assign
may be unassigned. To understand more specifically, suppose that you have
assigned physical channel CH1 to logical channel Group1:07, for example.
Because the non--inverted output of CH1 and that of CH2 are used for DTO
on the Group1:07, you can not assign physical channel CH2 to any other
logical channel. If you have assigned physical channel CH2 to a logical
channel, the assignment is unassigned.

� You cannot set DTO to any logical channel to which you have already
assigned an even--numbered physical channel (CH2 or CH4).

� You cannot assign any even--numbered physical channel (CH2 or CH4) to a
logical channel for which DTO has been turned on.
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� If you assign an odd--numbered physical channel (CH1 or CH3) to a logical
channel for which DTO has been turned on, the assignment to the associated
channel (CH2 or CH4) will be unassiigned. This rule applies if the assign-
ment has been established.

� The DTO feature is available also in the Pulse Generator mode.

Operation.
The Differential Timing Offset cell usually remains grayed out. To enable setup
of this feature, do the following:

On an unassigned channel or a channel to which you have assigned an odd--num-
bered physical channel, press the SELECT key to open the pop--up menu.
Alternatively, on such a channel, press theMENU key to open the Edit menu.
Then, select Differential Timing Offset from the menu.
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Channel Addition

This feature obtains the result of XOR or AND between (1) the output being
subject to Delay of the adjacent physical odd-- and even--numbered channels of
Slots A to D, and (2) the signal from the further adjacent physical channel.

For the odd--numbered channel, you can select Normal (through) or XOR (XOR
with the signal from the even--numbered channel). For the even--numbered
channel, you can select Normal (through) or AND (AND with the signal from
the odd--numbered channel).

For this setting, use Channel Addition in the Timing window. The settings in this
window are for the logical channels rather than the physical channels. You can
set Normal, XOR, and AND to a logical channel that you have not assigned a
physical channel. You can set Normal or XOR to a logical channel that you have
assigned an odd--numbered physical channel. Also you can set Normal or AND
to a logical channel that you have assigned an even--numbered physical channel.

The channel addition feature is available also in the Pulse Generator mode.

The amount of Delay you have set in Delay applies to any input signal used for
channel addition. Invert, which controls Polarity, is included after channel addition.

CH1

CH2

XOR

AND

CH1 OUT

CH2 OUT

Figure 1--36: Channel Addition

Operations.
Set up Channel Addition in the Channel Addition column.

You can set Normal or XOR on a channel to which you have assigned an
odd--numbered physical channel. You can set Normal or AND to a logical
channel to which you have assigned an even--numbered physical channel. You
can set Normal, XOR, or AND to a channel to which you have not assigned a
physical channel.

For this setting, select the Channel Addition cell. Next, press the SELECT key
to open the pop--up menu. Alternatively, press theMENU key to open the Edit
menu. Then, select the desired item(s) from the menu. Alternatively, in the
character input mode, you can type ’n’ for Normal, ’x’ for XOR, or ’a’ for AND
from the external keyboard.
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Polarity

Set the polarity of the output signal. If you set Invert, Data 0 and 1 are output at
the High and Low levels, respectively. Polarity takes effect on signals generated
after channel addition.

Operations.
Select the Polarity cell. Next, press the SELECT key to open the pop--up menu.
Alternatively, press theMENU key to open the Edit menu. Then, select Normal
or Invert from the menu. Alternatively, after you have selected the Polarity cell,
press the SPACE or ENTER key to toggle between the settings.
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Output Level

This section provides information about the Level window, including the output
level.

Figure 1--37: Level window (Data Generator mode)

Output Level

You can use the Level window to set the parameters related with the output level.
These parameters include the output level, the output level limits, and the
termination resistance and voltage. You can set the parameters for each of the
channels. The Level window allows you to view the information by either
channel or group. If a mismatch exists in terms of the parameter value for the
channel when the information is viewed by group, the item is marked with a
question mark (?).

Frequently used set values are available as predefined levels, which include
information about the termination resistance and voltage as well as the High and
Low values.

To set the output level, use a pair of the High and Low values and or of the
Amplitude and Offset values. You must choose the same pair (of High/Low and
Amplitude/Offset) for all the channels. You can set the level of the channels
independently.
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The DTG5000 software sets the hardware output level, considering the termina-
tion resistor and voltage of the connected device under test (DUT) relative to the
output level you set.

50Ω

V× 2

GND Vtt

RLΩ

Vout

V: Hardware output voltage for 50Ω to GND

Vout: Output voltage for the termination voltage Vtt and the termination
resistor RLΩ

Figure 1--38: Output level, termination resistor, termination voltage

Range of output level

The setting range of an output level differ by output/modules. The value which
can be set up by High/Low or Amplitude/Offset is as follows.

The setting ranges of an output level differ by the kind of output module
currently used. The value which can be set up by High/Low or Amplitude/Offset
is as shown in Table 1--20.

Table 1--20: Clock source

Item Range

DTGM10

Output Voltage (VOUT) --0.04×RL + Vtt � VOUT � 0.04×RL + Vtt
--3.00� VOUT � 7.00

High Level (VOH) --1.25 V to +2.00 V into 50 Ω to GND
--2.50 V to +7.00 V into 1 MΩ to GND

Low Level (VOL) --1.50 V to +1.75 V into 50 Ω to GND
--3.00 V to +6.50 V into 1 MΩ to GND
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Table 1--20: Clock source (cont.)

Item Range

Amplitude (VOH -- VOL) 0.25 Vp--p to 3.50 Vp--p into 50 Ω to GND
0.50 Vp--p to 10.00 Vp--p into 1 MΩ to GND

Resolution 5 mV

DTGM20

Output Voltage (VOUT) --0.08×RL + Vtt � VOUT � 0.08×RL + Vtt
--2.00� VOUT � 5.00

High Level (VOH) --0.90 V to +2.50 V into 50 Ω to GND
--1.80 V to +5.00 V into 1 MΩ to GND

Low Level (VOL) --1.00 V to +2.40 V into 50 Ω to GND
--2.00 V to +4.80 V into 1 MΩ to GND

Amplitude (VOH -- VOL) 0.10 Vp--p to 3.50 Vp--p into 50 Ω to GND
0.20 Vp--p to 7.00 Vp--p into 1 MΩ to GND

Resolution 5 mV

DTGM30

Output Voltage (VOUT) --0.07×RL + Vtt � VOUT � 0.07×RL + Vtt
--3.00� VOUT � 7.00

High Level (VOH) --1.00 V to +3.27 V into 50 Ω to GND
--1.94 V to +7.00 V into 1 MΩ to GND

The following relational expressions must be satisfied:
VOH � 7.00
VOH � (7.00× RL + 50× Vtt ) / ( RL + 50 )
VOH � RL / 50× ( 2.5 -- 0.06× RL / ( RL + 50 )) + Vtt
( --2.00× RL + 50× Vtt ) / ( RL + 50 )� VOH
VOH � Vtt -- RL / 50

Low Level (VOL) --2.00 V to +3.24 V into 50 Ω to GND
--2.00 V to +6.94 V into 1 MΩ to GND

The following relational expressions must be satisfied:
VOL � --2.00
VOL � (50× Vtt -- 4.5× RL ) / ( RL + 50 )
VOL � Vtt -- RL× (0.02 + 2.5 / ( RL + 50 )) + Vtt
( --2.00× RL + 50× Vtt ) / ( RL + 50 )� VOL
VOL < (( 2.5 -- 0.06)× RL / 50 ) + Vtt
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Table 1--20: Clock source (cont.)

Item Range

Amplitude (VOH -- VOL) 0.03 Vp--p to 1.25 Vp--p into 50 Ω to GND
0.06 Vp--p to 2.50 Vp--p into 1 MΩ to GND

The following relational expressions must be satisfied:
( VOH -- VOL )> 2×( Vtt -- RL / 50 -- Offset )
( VOH -- VOL )> 2×((( RL×( --2 ) + 50×Vtt ) / ( RL + 50 ) -- Offset )
( VOH -- VOL )> 2×(( 2.5×RL -- 50×Offset + 50×Vtt ) / ( 2×RL +
50 ))
( VOH -- VOL )> 2×(( 7×RL -- 50×Vtt ) / ( RL + 50 ) -- Offset )

Resolution 5 mV

H and L Limits of Output Level

The High and Low Levels can be limited to the values of the High and Low
Limits. You can set them for each channel independently. You can also turn on or
off the limit separately for each of the channels. If you set the high or low level
beyond the Limit setting when Limit is enabled, the High or Low Limit value
will be selected.

1. To set High or Low Limit, select the cell to set and then enter a value using
numeric keys or the knob.

2. To turn Limit on or off, select the cell to set and then press the ENTER key.
Press the ENTER key to toggle between On and Off. Alternatively, press the
SELECT orMENU key, and then set to On or Off in the menu displayed.

Operations
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Termination resistor

Sets the DUT’s termination resistance numerically in ohms. You can set a value
from 10 Ω to 1 MΩ or Open. Varying the termination resistance changes the
DTG5000 Series hardware level settings with the High/Low levels. Note that the
DTG5000 Series output impedance is fixed to 50 Ω.

1. Select the cell to set and then enter a value using numeric keys or the knob.
If you use numeric keys, you do not need to add Ω.

2. If you want to set Open, in the menu displayed, select the cell and then press
either the SELECT orMENU key. (You can also use the minus or ENTER
key for setting.)

Termination Voltage

Sets the DUT’s termination voltage numerically in volts. You can set a value
from +5.0 to --2.0 V in 0.1 V steps. Varying the termination voltage changes the
DTG5000 Series hardware level settings with the High/Low levels unchanged.

1. Select the cell to set and then enter a value using numeric keys or the knob.

Output On/Off

Simultaneously turn on or off the output relay for all the channels. The RUN
button comes on by turning it on and the signal is output. If you have not
assigned a physical channel to the logical channel, you cannot turn it on.

1. Select the cell to set and press the ENTER key. Pressing it toggles between
On and Off. Alternatively, press the SELECT orMENU key, and then set
On or Off in the menu displayed. Pressing the ALL OUTPUTS ON/OFF

button on the front panel allows you to set all the channels to On or Off.

Operations

Operations

Operations
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Predefined Level

The typical level settings are predefined as shown below. The High/Low levels,
the termination resistance and voltage can be specified together.

Table 1--21: Predefined Output Levels

Name High Level Low Level
Termination
Voltage

Termination
Impedance

TTL (into open) 2.5 V 0.0 V 0.0 V Open

TTL (into 50Ω to GND) 2.5 V 0.0 V 0.0 V 50 Ω

CMOS 5V (into open) 5.0 V 0.0 V 0.0 V Open

CMOS 3.3V (into open) 3.3 V 0.0 V 0.0 V Open

ECL (into 50Ω to --2V) --0.9 V --1.7 V --2.0 V 50 Ω

PECL (into 50Ω to +3V) 4.1 V 3.3 V 3.0 V 50 Ω

PECL (into 50Ω to +5V) 4.1 V 3.3 V 5.0 V 50 Ω

LVPECL (into 50Ω to +1.3V) 2.4 V 1.6 V 1.3 V 50 Ω

LVPECL (into 50Ω to +3.3V) 2.4 V 1.6 V 3.3 V 50 Ω

LVDS (into 100Ω differential) 1.4 V 1.0 V 1.2 V 50 Ω

TMDS (into 50Ω to +3.3V) 3.3 V 2.8 V 3.3 V 50 Ω

RSL (into 28Ω to 1.8V) 1.8 V 1.0 V 1.8 V 28 Ω

CML (into 50Ω to GND) 0.0 V --0.41 V 0.0 V 50 Ω

1. Select the cell for the channel to be set. Press either the SELECT orMENU

key and select Predefined Level... in the menu displayed.

2. In the Predefined Level dialog box, use the Up, Down, Left, or Right arrow
key to select the level name.

3. Use the TAB key to activate OK. Then, press the ENTER key to determine
the selection.

Operations
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DC Output

This section describes DC output.

The DC output connectors for eight channels are provided on the right side of the
front panel. To set up the DC output, you can use the DC Output window. You
can set Level, High Limit, Low Limit and Limit On/Off for each of the channels.
The DC Output exists independently without being included in the grouping of
the logical channels. In addition, it does not enable grouping setup.

CH0
CH1
CH2
CH3
CH4
CH5
CH6
CH7

GND
GND
GND
GND
GND
GND
GND
GND

Figure 1--39: DC output pin assignments

L Limit

Level

H Limit

Figure 1--40: DC Output window

The DC Output window initially contains mainframe numbers 1 to 3 and Dn (n =
0 to 7) names assigned. D0 corresponds to CH0.
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Output Level and Limit

You can set the output level (Level) and limits H Limit and L Limit within the
following ranges:

--3.0 V� Level � +5.0 V
--3.0 V� L Limit� H Limit� +5.0 V

If Limit is set to On, the Level setting is adjusted to satisfy the following:

--3.0 V� L Limit� Level � H Limit� +5.0V

1. Select the cell containing the desired Level or H Limit or L Limit setting.

2. Then, set the value using numeric keys or the knob.
Or press the SELECT key to open the pop--up menu. Alternatively, press the
MENU key to open the Edit menu. The edit menu shows frequently used set
values.

3. Turn the Limit on or off by selecting the cell to set and press the ENTER
key to toggle on or off. Alternatively, press the SELECT orMenu key to
display the menu, and then set to On or Off.

Operations
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Predefined level

Frequently used set values are available as predefined levels. Unlike Preset Level
in the Level window, you can use them only for the Level setting. The value
chosen with the menu is set to a cell with cursor.

Table 1--22: Predefined DC levels

Clock Source High l Low

TTL 2.5 V 0.0 V

CMOS 5V 5.0 V 0.0 V

CMOS 3.3V 3.3 V 0.0 V

ECL --0.9 V --1.7 V

PECL 4.1 V 3.3 V

LVPECL 2.4 V 1.6 V

LVDS 1.4 V 1.0 V

TMDS 3.3 V 2.8 V

RSL 1.8 V 1.0 V

CML 0.0 V --0.41 V

Output On

This check box sets to turn On or Off for the DC outputs of all the channels.
While a check mark is placed on the check box, the DC output is on. Operating
the ALL OUTPUTS ON/OFF button on the front panel also controls the DC
output. When you turn on or off the pattern signal output using the ALL
OUTPUTS ON/OFF button, the DC output state also changes correspondingly.

1. Activate Output On using the TAB key.

2. Press the SPACE key to toggle between the check mark on and off settings.

3. Pressing the ALL OUTPUTS ON/OFF button on the front panel also
allows you to set the DC Output channels to On or Off.

The RUN button on the front panel, which controls the pattern signal output,
does not control the DC output. The DC output is controlled by check the check
mark in the Output On box or the ALL OUTPUTS ON/OFF button.

Operations
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Trigger

The trigger is used to control signal output. In the Data Generator mode, you can
start the output by pressing the RUN button, regardless of the trigger signal. The
trigger signal is used for Wait Trig in the sequence table. In the Pulse Generator
mode, the trigger signal is used for starting the output when the Run mode is the
burst mode.

The trigger signal is generated by pressing the MANUAL TRIGGER button on
the front panel as well as by specifying the signal with the trigger source. When
the MANUAL TRIGGER button was pushed, it becomes an effective trigger
regardless of the trigger source.

Parameters

The following trigger parameters are available. You can set them using the
Timebase window.

Rising edge

Level

Interval

Falling edge

Figure 1--41: Trigger parameters



Trigger

1--74 DTG5078 & DTG5274 Data Timing Generator User Manual

Figure 1--42: Time Base window (Data Generator mode)

Table 1--23 shows setup items of trigger parameters on the Time Base window.

Table 1--23: Trigger parameters on Time Base window

Items Description

Source Internal: Uses the trigger signal generated in the DTG5000 Series.

External: Uses the external signal connected to the trigger connector
on the front panel. You can use signal from --5 to +5 V for 50 Ω, or
from --10 to +10 V for 1 kΩ source.

Interval Specifies the interval of the internal trigger. You can set a value from
1.0 �s to 10.0 s.

Slope Specifies the edge at which the trigger is to be generated. Specify
this when you use the external trigger.

Positive: Generates the trigger at the rising edge.
Negative: Generates the trigger at the falling edge.

Level Specifies the trigger level at which the external trigger is generated.
You can set a value from --5 to +5 V in 0.1 V steps.

Impedance Specifies external trigger impedance. Selects either 50 Ω or 1 kΩ
for the impedance when the external trigger is used.
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Sequence

This section describes about sequences and how to create a sequence.

What is a Sequence?

A sequence is a list of data that is prepared by combining blocks. You can output
a complex pattern by controlling simply listed blocks with a sequence definition,
which contains the settings of Repeat (number of repetitions), WaitTrig (wait for
trigger), Jump If (jump determined by the event information), and Goto (change
the output sequence).

Each sequence may be defined as either the main sequence or a subsequence.
The main sequence consists of one or more blocks and zero or more subse-
quence. One main sequence can be defined in the whole system. A subsequence
consists of one or more blocks.

In a subsequence, define the number of block repetitions. In a sequence, you can
define blocks, the number of subsequence repetitions, and jumps determined by
the conditions to output complex signals.

Procedure for Creating a Sequence

The DTG5000 software default setup contains a defined sequence that outputs an
endlessly repeated pattern of Block1. This means that the DTG5000 software
signal output is performed according to the sequence definition and output of the
signal requires definition of the sequence. To define a sequence, do these steps:

1. Using the Blocks window, create the necessary number of blocks, which are
elemental units of pattern data.

2. Create the pattern of each block using the Data--Listing or Data--waveform
window.

3. If necessary, define subsequences using the Sub--sequences window. In each
subsequence, define a list of blocks and the number of block repetitions.

4. In the Sequence window, specify the blocks and subsequences to use. Define
the number of repetitions, whether to wait for the trigger, and the sequence
for the destination of Jump and the other required sections.

5. In the Sequences window, also define the parameters related with sequence
operation, e.g., Sequence Mode, Jump Mode, and Jump Timing. The
sequence that can be output depends on the option you select in Sequence
Mode.
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For creating a pattern of blocks, refer to the “Pattern Edit” section.

The following trigger parameters are available. You can set them using the
Timebase window.

Create Sub--sequences

main sequence

Create Block and pattern data

Blocks window Data--Listing window
or
Data--Waveform window

Sub--sequence window

Sequence window

Block1

Block1 × 10

Block6

Block5

Block4

Block3

Block2
Block1

Sub1

Sub2

Block3 × 10

Block5 × 10

Block4 × 10

Block1 × 100

Block4 × 200

Block6 × 200

Block5 × 300

Block2 × 20

Sub2 × 1000

Sub1 × 1000

Event Jump

Go To

Event Jump

Wait Trigger

0100101001110
0010001000100
1101011001011

Figure 1--43: The procedure of sequence creation
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Sequencer Mode

The sequencer runs sequences that you have created using the Sequence window.
Two sequencer modes are available: Hardware and Software Sequencer.

Hardware Sequencer implements sequence output by controlling the hardware’s
sequencer with software.

Software Sequencer deploys the sequence definition in pattern memory by means
of software without using the hardware’s sequencer. This enables the Software
Sequencer to meet two purposes:

� Restricting the minimum block length

� Enabling the output of patterns without the limit of the Block size granularity

� Expanding the nesting level of subsequence up to 5 levels

Therefore, there are restrictions on the operation and functions that may vary in
state during execution of an instruction such as Event Jump. The following table
summarizes the differences between the two sequencers:

Table 1--24: Differences between Hardware and Software Sequencers

Hardware Sequence Software Sequencer

Limit of minimum
block size

Applied (usually, 240 words/channel
for DTG5078, or 960 words/channel
for DTG5274)

Not applied

Block size granu-
larity

Applied only for DTG5274 Not applied

Nesting level of
subsequence

1 level only Up to 5 levels

Jump Not limited Disabled

Go to Not limited Disabled (You can specify the
destination of Go To only on the last
line in the main sequence.)

Trigger Wait Not limited Disabled (You can specify this only
on the first line in the main se-
quence.)

Infinite Loop Not limited Disabled (You can specify this only
on the last line in the main se-
quence.)

Restrictions on
use of pattern
memory

Not applied Because all the sequences are
deployed in pattern memory, a
memory overflow error may occur
with an excessive loop count.



Sequence

1--78 DTG5078 & DTG5274 Data Timing Generator User Manual

Jump Mode

For the jump mode during sequence output, event jump and command jump are
available. You can select a jump mode in the Data Generator mode only when
the sequencer mode is the Hardware Sequencer.

Table 1--25: Jump modes

Items Description

Event jump Jumps to the line that has the label defined with Event Jump To in
the sequence table, when an event is received. There are three
acceptable events: generation of the input signal to the front panel’s
EVENT IN connector, pressing the MANUAL EVENT button, and
issuing remote command TBAS:EIN:IMMEdiate.

Command jump Jumps to the line that has the specified label, when remote
command TBAS:JUMP<label> is received. If the long delay is on,
the command jump is disabled.

Jump Timing

Specifies the timing of the control jumps when a trigger for the event or
command jump is generated. When selection of the jump mode is enabled, you
can also select the jump timing.

Table 1--26: Jump timing

Items Description

Async Jumps immediately, when an event or remote command is received.

Sync Jumps after completing output of the current block, when an event or
remote command is received.
For example, suppose that a line defines that Block1 repeats 10
times. If an event occurs while the third run is in progress, control
jumps after completing data output of the block of the third run.
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Main Sequence

Only one main sequence exists in the whole system. By default, you have a main
sequence that outputs an endlessly repeated pattern of Block1. The main
sequence contains up to 8,000 lines for definition. To define sequences including
the main sequence, you can use the Sequence window.

Figure 1--44: Sequence window

In the Sequence window, you can set the following:

Table 1--27: Setup items for Sequence window

Items Description

Sequence Mode Specifies the sequencer mode (Hardware or Software Sequencer).

Jump Mode Specifies a jump by an event caused by an external event signal, a
press of the front panel’s button, or a remote command. Also
specifies a command jump caused by a remote command.

Jump Timing Selects ASync which jumps immediately or Sync which jumps not
immediately (waits for the completion of current blocks outputs).

Label Sets the line name. Accepts up to 16 characters for the label name.
You can define up to 8,000 lines for a sequence. This label may be
used as a destination of Jump To and Go To.

Wait Trig. Specifies whether to wait for the trigger before the contents of the
line are output. Select On or Off (blank) for setting. You can also use
the SPACE or ENTER key, instead of setting in the menu.
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Table 1--27: Setup items for Sequence window (cont.)

Items Description

Block/Sub-sequence Specifies the name of the block or subsequence to be output on the
line. Accepts up to 32 characters.

The already defined block and subsequence names are listed in the
menu displayed by pressing the MENU, SELECT, or right mouse
button. You can select the desired one also from the list.

Repeat Specifies the number of block or subsequence repetitions. Accepts
an integer from 1 to 65536 or Infinite.

To set Inf., use the menu that is displayed by pressing the MENU,
SELECT, or right mouse button, or press 0 + ENTER keys.

Note:
When the number of Repeat is set as a subsequence, “the number
of times of a sub--sequence×the number of Repeat” of lines are
required on the sequence memory.

Example: If Repeat=5000 are set as the subsequence of two lines, it
requires 2x5000=10000 (>8000) lines of sequence memory. and will
make to an error at the time of loading a sequence.

Event Jump To Specifies the label of the line to which control jumps when an event
occurs while the contents of the current line are being output. If the
cell is left blank, control will not jump.

Go To Specifies the label of the line to which control jumps unconditionally
after the contents of the current line are output. If the cell is left
blank, control goes to the next line.
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Subsequence

A sequence in the main sequence is called a subsequence. A subsequence permits
you to define the blocks and the number of block repetitions. You can define up
to 256 lines in a subsequence, and define up to 50 subsequences. The subse-
quence nesting level can be up to 1 for the Hardware Sequencer or 5 for the
Software Sequencer.

In the Sub--sequences window, you can display and edit information about
subsequences. The Sub--sequence List (left) contains the names of the already
created subsequences. Selecting a subsequence from the lists shows its details on
the right. When you create a new Sub--sequence, input a name into a Sub--se-
quence list.

Figure 1--45: Sub--sequence window

Sub--sequences window
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In the Sub--sequence table, you can set the following:

Table 1--28: Setup items for Sequence window

Items Description

Block Specifies the name of the block to be output on the line. Accepts 32
characters for a block name. Enter the name in ALPHA input mode
or from the external keyboard. The already defined block names are
listed in the menu displayed by pressing the MENU, SELECT, or
right mouse button. You can thus select the desired one from the list.
You can set up the sequence nesting by defining the subsequences.
If you use the Software Sequencer, you can set up nesting of up to 5
levels.

Repeat Specifies the number of block repetitions. Accepts an integer from 1
to 65536. Does not accept Infinite.
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Jitter Generation

This section details the Jitter generation of the DTG5000 Series.

Jitter generation on the DTG5000 series

The jitter generation function that the DTG5000 Series offers is to write a pattern
in RAM in advance and move the delay value of the signal of Channel 1 by the
value of that pattern. You can select Sine, Square, Triangle, or Gaussian Noise
for the jitter pattern. Because Channel 2 is used for jitter generation, it will be
not available for usual signal output.

Two modes are available for jitter type: All, which swings the whole and Partial
By, which allows jitter to be partially inserted. You can select “Rise only,” “Fall
only,” or “Both” for the edge(s) where jitter is applied.

The following restrictions are imposed on jitter generation:

� It is enabled when Long Delay is off in the Data Generator mode.

� In the Pulse Generator mode, a jitter generation is disabled.

� The jitter can be applied only to Channel 1 of Slot A of the master.

� Channel 2 is internally used for jitter generation. Channel 2 will thus be
disabled, thereby forcibly resetting the assignment to Channel 2.

� For the same reason, the channel composition function of Channel 1 is
disabled.

� In the DTG5000 Series, the timebase for pattern generation (clock) and for
jitter generation is entirely independent of each other (async); no repeatabil-
ity is included in the characteristics of jitter generation. In addition, there is
no guarantee that jitter generation starts at the head of the jitter profile.
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Jitter Off

Jitter Frequency = 1 / Jitter Period

Edge: Both

Jitter Profile: Triangle

Jitter Amplitude

Jitter
Period

Jitter: All, Edge: Both

Figure 1--46: Jitter Generation parameters

All Pattern Jitter

To generate jitter, vary the delay of the leading and/or trailing edge of Channel 1
by using the data generator, which is controlled with the specified Jitter Profile
( the transition pattern of the amount of delay(s)), Frequency (jitter frequency),
and Amplitude (width of jitter).

Connect the same signal of Channel 1 to the Channel 1 and Channel 2 delay
lines, and use them while switching the delay line with the switch.

Actually, the amount of delay is varied according to the sequence below, and
jitter is generated while the delay line is switched with the timing. The amount
of delay of the output signal is varied consecutively.
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� Set the switch to Delay Line #2. (The signal is output with the amount of
delay that was set for Delay Line #2.)

� Wait until Delay Line #1 is emptied.

� Set the amount of delay for Delay Line #1 for the amount of jitter that will
be output next.

� After completion, set the switch to Delay Line #1 at a convenient point to
partition the pattern from Delay Line #2. (The signal is output with the
amount of delay that was set for Delay Line #1.)

� Wait until Delay Line #2 is emptied.

� Set the amount of delay for Delay Line #2 for the amount of jitter that will
be output next.

� After completion, set the switch to Delay Line #2 at a convenient point to
partition the pattern from Delay Line #1. (The signal is output with the
amount of delay that was set for Delay Line #2.)

. . . . . . . . . . . . . . . .

CH1 OUT

Jitter PatternReady Signal

Patter Gen
(Delay Line Control)

Delay #1

Delay #2

CH1

CH2

XOR

Figure 1--47: Jitter Generation (All pattern jitter)
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Partial Pattern Jitter

You can apply jitter to any specified section of the pattern. To specify the section
to which jitter is applied (called the Jitter On area), use the pattern data for the
logical channel you specified by Partial By.

Actually, partial pattern jitter is applied using the following procedure internally:

� In Channel 1, enter the Channel 1 data from which the data in the Jitter On
area was cut, that is, the Jitter On area data replaced with 0s.

� In Channel 2, enter the Jitter On area data that was cut from Channel 1, that
is, all 0 data except the Jitter On area.

� Fix the amount of delay of Channel 1 to 0.

� To generate jitter, vary the delay of the leading and/or trailing edge of
Channel 2 by using the pattern generator, which is controlled with the
specified Jitter Profile (the transition pattern of the amount of delay(s)),
Frequency (jitter frequency), and Amplitude (width of jitter).

� Obtain the XOR value of the two signals.

CH1

CH2

Jitter PatternReady Signal

Patter Gen
(Delay Line Control)

Delay #2

Delay #1
= Fixed

XOR CH1 OUT

Figure 1--48: Jitter Generation (Partial pattern jitter)

The sections in which jitter is applied are those sections denoted by “Gate on”
that have 1 as the value of the specified logical channel. The NRZ format is used
as for a gate pattern regardless of the specified logic channel. You can set any
number of Jitter On areas.
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If the data format of Channel 1 is NRZ or RZ, jitter is applied at the edge of the
pulse the rising section of which is included in the Gate On area. This occurs for
each positive pulse, for the Rise/Fall pairs. Also if you have selected Fall for
Edge, whether jitter is applied depends on whether the rising section of the pulse
is included in the Gate On area. This occurs for each positive pulse, for the
Rise/Fall pairs.

If the data format of Channel 1 is R1, jitter is applied at the edge of the pulse the
falling section of which is included in the Gate On area. This occurs for each
negative pulse, for the Fall/Rise pairs. Also if you have selected Rise for Edge,
whether jitter is applied depends on whether the falling section of the pulse is
included in the Gate On area.

In addition, when a data format is NRZ, Jitter may not be applied in a Gate On
area at the beginning of or end of a block.

= Edge which jitter is applied

NRZ
Edge: Both

RZ
Edge: Both

R1
Edge: Both

Gate
(Partial By Channel

NRZ
Edge: Rise

NRZ
Edge: Fall

Figure 1--49: Edge which jitter is applied
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Parameters

In the Jitter Generation window, you can set the following jitter parameters:

Figure 1--50: Jitter Generation window

Table 1--29: Jitter Generation window settings

Setting Description

Jitter Generation in Slot
A CH1 (Jitter Mode)

Off: Turns off jitter generation.

All: Applies a jitter to the whole pattern of Channel 1 in Slot A.

Partial: Applies a jitter to part of the pattern of Channel 1 in Slot A.
Using the combo box of the Partial By, select the channel to be used
as the gating source. Partial pattern jitter is applied at a point where
the logical channel you selected for the gating source is 1.

Profile Select Sine, Square, Triangle, or Gaussian Noise for the profile of
jitter.

Edge Specifies the edge at which to apply the jitter. You can specify Rise,
Fall, or Both.
Rise: Applies jitter only at the rising edge.
Fall: Applies jitter only at the falling edge.
Both: Applies jitter at each of the rising and falling edges.
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Table 1--29: Jitter Generation window settings (cont.)

Setting Description

Frequency Sets the repetitive frequency of the profile. Accepts a value from
0.015 Hz to 1.56 MHz. Not available if you have selected Gaussian
Noise for the profile.

Amplitude
Unit

Set the profile amplitude and jitter width. For the unit, you can select
either Second or UI (unit interval, i.e., 1 clock period in DTG5000
Series). To specify these, use the peak--to--peak or RMS value,
respectively. The relationship between peak--to--peak and RMS is as
follows:
Sine: 1 UIrms = 2√2 UIp--p
Square: 1 UIrms = 2√3 UIp--p
Triangle: 1 UIrms = 2 UIp--p
Gaussian Noise: 1 UIrms = 12 UIp--p

Because the width of jitter swings the same amount toward the
positive and negative directions, you cannot set it if the amount of
Lead Delay is 0. The maximum jitter amplitude will be obtained.
when the value of Delay Offset is set as 2.5ns.

Table 1--30 summarizes the valid ranges of the jitter amplitude.

Table 1--30: Maximum jitter amplitude

Jitter Edge
Data For-
mat Jitter Mode Jitter Profile Maximum jitter amplitude (UIp--p)

Both NRZ only All pattern jitter Sine ( 1 -- 290 ps / Period )× 9.9 e5 / Fj
Condition1 must be satisfied.

Other than Sine 1 -- 290 ps / Period
C diti 1 t b ti fi d

Partial pattern jitter any
Condition1 must be satisfied.

includes RZ
or R1

All pattern jitter Sine ( Period -- Pulse width -- 290 ps) / Period × 9.9 e5 / Fj
Condition1 must be satisfied.

Other than Sine ( Period -- Pulse width -- 290 ps) / Period
C diti 1 t b ti fi d

Partial pattern jitter any
Condition1 must be satisfied.

Rise/Fall NRZ only any any ( Period -- 290 ps) / Period ×2
Condition1 must be satisfied.

includes RZ
or R1

any any ( Min {Pulse width, Period -- Pulse width} -- 290 ps) / Period ×2
Condition1 must be satisfied.
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Table 1--30: Maximum jitter amplitude (cont.)

Jitter Edge Maximum jitter amplitude (UIp--p)Jitter ProfileJitter Mode
Data For-
mat

Condition1 Lead Delay + Ajs_p--p / 2� Maximum of Lead Delay
and
Lead Delay -- Ajs_p--p / 2� Minimum of Lead Delay

where Ajs_p--p = Ajui_p--p × Period (Period = 1 UIp--p)
Ajui_p--p = Jitter Amplitude on UIp--p

If the data format for Channel 1 is R1 or RZ, Condition2 below must be satisfied:

Condition2 Trail Delay + Ajs_p--p / 2� Maximum of Trail Delay
and
Trail Delay -- Ajs_p--p / 2� Minimum of Trail Delay

Where Fj: Jitter Frequency
Ajui_p--p: Jitter amplitude represented by UIp--p
Ajui_rms: Jitter amplitude represented by UIrms
Ajs_p--p: Jitter amplitude represented by Sec p--p
Ajs_rms: Jitter amplitude represented by Sec rms
Ajui_p--p × Period = Ajs_p--p
Ajui_rms × Period = Ajs_rms



DTG5078 & DTG5274 Data Timing Generator User Manual 1--91

DTG5000 Configuration Utility

The DTG5000 Configuration Utility software is independent of the DTG5000
software. This utility allows you to switch the DTG5000 software between
online and offline or set up Master--Slave operation.

Startup

You can start the DTG5000 Configuration Utility from the Start menu. (It is
actually a file named Config.exe, which is located in the folder containing the
DTG5000 software.) If you attempt to start the utility while the DTG5000
software is running, you will enter the View--Only mode, which prevents you
from performing setup and other operations. If you want to modify the settings
with this utility, be sure to first exit the DTG5000 software.

1. If the DTG5000 software is running, press theMENU key and select Exit
from the File menu to exit the software.

2. Press CTRL + ESC to open the Start menu. Using the Up, Down, Left,
and/or Right arrow key, select Programs / Tektronix / DTG5000 /
DTG5000 Configuration Utility.

3. Press the ENTER key to start the DTG5000 Configuration Utility. The
utility provides you with two windows: for Online and Offline modes.
Actually, you see the window corresponding to the current mode setting.

Selecting Mode

Online mode Offline mode

Figure 1--51: DTG5000 Configuration Utility
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Mode

The DTG5000 software runs in either the Online or Offline mode. The DTG5000
Configuration Utility opens the window corresponding to the mode. To select the
mode, use the Mode area in the Configuration dialog box.

The Online mode runs on the DTG5000 Series mainframe and performs the
entire process to control the DTG5000 Series hardware. You use this mode to
output a signal. Your system configuration is recognized and applied automati-
cally, including the mainframe you are using, currently installed output modules
and their counterpart slots.

The Offline mode runs on the PC or DTG5000 Series mainframe. It performs the
entire process from creating and editing the pattern data to setting up the output
parameters, with the hardware disconnected. You can combine the mainframe
and output modules as desired, provided they meet the restrictions. You can use
this mode until you press the RUN button to output signals. It allows you to save
the results of the work in a settings file, and then loads and outputs it in the
Online mode.

DTG5000 Configuration Utility in Online Mode

Select the Online checkbox in the Mode area in the DTG5000 Configuration
Utility software. The window for the Online mode appears.

Figure 1--52: DTG5000 Configuration Utility Online mode

Online mode

Offline mode



DTG5000 Configuration Utility

DTG5078 & DTG5274 Data Timing Generator User Manual 1--93

Table 1--31: Setting for DTG5000 Configuration Utility in Online mode

Setting Description

System Configuration Specifies whether the Master--Slave operation can be performed,
and (if you select it) its configuration.

Master: If you do not specify that Master--Slave operation be
performed, select Master.

Master/Slave#1, Master/Slave#1/Slave#2: If you specify that
Master--Slave operation be performed, specifies as the master
machine. Select either according to the number of slave machines.
For DTG5274, you can use only one slave machine.

Slave: If you specify that Master--Slave operation be performed,
specifies as the slave machine.

Slaves In Master--Slave operation, the slave machines are controlled via
LAN. Specify the names or IP addresses of the desired slave
machines in the DTG5000 Configuration Utility on the master
machine.

Set by Selects the way in which you will specify each slave machine.

Computer Name: Specifies that you will use the computer name. If
you select Computer Name, enter the name in the combo box under
this field. If you set it previously, you can use the Up and/or Down
arrow key to select the previously set name from the list. Selecting
the Browse button displays the network computer’s browser, where
you can select the slave machine.

IP Address: Specifies that you will use the IP address. If you select
IP Address, enter the address in the box under this field.

Remote Control For DTG5000 Series, you can enable remote control only through
GPIB. Specify the GPIB device address in this box by setting any
address from 0 to 30.
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DTG5000 Configuration Utility in Offline Mode

Select the Offline checkbox in the Mode area in the DTG5000 Configuration
Utility, the window for the offline mode appears.

Figure 1--53: DTG5000 Configuration Utility Offline mode

Table 1--32: Setting for DTG5000 Configuration Utility in Offline mode

Setting Description

System Configuration Specifies whether the Master--Slave operation can be performed,
and (if you select it) its configuration.

Master: If you do not specify that Master--Slave operation be
performed, select Master.

Master/Slave#1, Master/Slave#1/Slave#2: Specify the number of
slave machines used for Master--Slave operation. Select either
according to the number of slave machines. If you are using
DTG5274 for the mainframe, you can use only one slave
machine.

Slave: Not available in Offline mode.

Mainframe Selects either DTG5078 or DTG5274 for the mainframe.
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Table 1--32: Setting for DTG5000 Configuration Utility in Offline mode (cont.)

Setting Description

Master Slot Configuration Specifies the conditions of the master machine’s slots. For each
of the slots, specify the slots and the output modules installed in
the slots. The available slots vary depending on the mainframe.

For the installation condition of each slot, you can select one of
the following: DTGM10, DTGM20, DTGM30 or no module
(empty).

If you select the Use same type of Output Module for all slot
checkbox, the settings specified for a slot will be applied to all the
other slots.

Slave #1 Slot Configuration
Slave #2 Slot Configuration

If you have specified that the Master--Slave operation be
performed in System Configuration, set the slot conditions of the
slave machines. The setting details are the same as for the
master machine.

Exit

After you have completed the required settings in Online or Offline mode, click
the OK button to exit the DTG5000 Configuration Utility.

Then, select the Start menu > Programs > Tektronix > DTG5000 > DTG5000 to
start the DTG5000 software. The settings made with the DTG5000 Configura-
tion Utility will take effect on the DTG5000 software.



DTG5000 Configuration Utility

1--96 DTG5078 & DTG5274 Data Timing Generator User Manual



DTG5078 & DTG5274 Data Timing Generator User Manual 1--97

Master- Slave Operation

When you use one unit of the DTG5000 Series mainframe, the DTG5078 can
output up to 32 channels of signals, and the DTG5274 up to 8 channels. The
Master--Slave operation is a feature that allows you to use more channels of
signals than the maximum number of channels of one unit. This is possible by
operating multiple units of the same model of mainframes. A unit that controls
the overall system is called Master, and a unit that is used for additional channels
is called Slave. If the DTG5274 is used as a master, one unit of DTG5274 can be
used as a slave. If the DTG5078 is used as a master, up to two units of DTG5078
can be used as slaves.

In the Master--Slave operation, the master and slaves should be connected
directly for the Clock and Event signals, because the timing is critical. For other
signals, the master controls the slaves through a LAN. You can configure the
overall system, prepare pattern data and set output parameters through the
corresponding windows of the master unit. The screen of each slave unit displays
only its operating status and does not allow any operation other than exiting the
program.

Preparing the Master/Slave Operation

To execute the Master--Slave operation, you must connect the master unit and
each slave unit with cables and configure the master unit’s system for Master--
Slave operation.

To synchronize the clock and jump timing on the overall system, connect the two
types of signals and establish a LAN as shown in Figure 1--54 on page 1--99
and Figure 1--55 on page 1--100.

As a clock source, use the clock selected on the master. To supply the clock
signal Sync Clock Out generated from the master to all the units:

� Connect the Sync Clock Out/Out signals of the master unit to Sync Clock
In/In of the slave units.

� Also connect the Sync Clock Out/Out signals of the master unit to Sync
Clock In/In of the master unit.

� The cables to be used must conform to the requirements of length and
characteristics. Use the specified SMA cable (P/N: 174--1427--00 made by
Tektronix).

Connecting the Cables
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Also for the Sync Jump control signals:

� Connect Sync Jump Out1, Out2, and Out3 of the master to Sync Jump In of
the master, to that of slave 1, and to that of slave 2, respectively.

� For the connection, use the BNC cable (P/N: 012--0076--00 made by
Tektronix).

NOTE. Use the specified cables for connection. If you use cables other than those

specified, the operation cannot be guaranteed.

Do not apply any signal other than specified to the Sync Clock In and Sync Jump

In input connectors because doing so may cause a fault.

When stacking the mainframes for use, do not stack more than three units. Do

not forget to fold the stand at the bottom of the cabinet.
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SMA Cable (P/N: 174--1427--00)

BNC Cable (P/N: 012--0076--00)

LAN Cable (10BASE--T/100BASE--TX cable)

Local
Ethernet
Network

DTG5274 Master DTG5274 Slave1

In

In

Out1

Out2

Out2

Out1

In

Out1

Out2

LAN

Sync Clock

Sync Jump

Sync Clock

Sync Jump

LAN

In

In

Out1

Out2

Out2

Out1

In

Out1

Out2

Figure 1--54: Master--Slave cable connection (DTG5274)
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Block3

Sync Clock

Sync Jump

DTG5078 Master DTG5078 Slave1

DTG5078 Slave2

In

In

Out1

Out2

Out3

Out3

Out2

Local
Ethernet
Network

In

Out1

LAN

Out2

Out3

Out1

Sync Clock

Sync Jump

Sync Clock

Sync Jump

LAN

LAN

In

Out1

Out2

Out3

In

Out1

Out2

Out3

In

In

Out1

Out2

Out3

Out3

Out2

Out1

In

In

Out1

Out2

Out3

Out3

Out2

Out1

SMA Cable (P/N: 174--1427--00)

BNC Cable (P/N: 012--0076--00)

LAN Cable (10BASE--T/100BASE--TX cable)

Figure 1--55: Master--Slave cable connection (DTG5078)
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Before connecting LAN cables, check that the master and slave DTG5000 Series
units have different computer names. If the same name is used for multiple units,
give different names.

NOTE. Setting or changing a computer name requires the Administrators access

level.

Although it can be operated from a front panel with text input mode, if an
external keyboard and mouse are used, setting or changing the operation can be
performed easily

1. Press the CTRL+ESC keys to display the Start menu.

2. Select Settings/Control Panel by pressing the arrow keys and press the
ENTER key.

3. Select System in Control Panel by pressing the arrow keys and press the
ENTER key. System Properties will be displayed.

4. Select the NetworkIdentification tab by pressing the CTRL+TAB keys.
The computer identification information will be displayed. Check the
computer name here.

5. To change the computer name, select the Properties button by pressing the
TAB key, then press the ENTER key.

6. Select Computer Name and press the ALPHA key to activate the text input
mode. Enter a new computer name.

7. Select the OK button and press the ENTER key.

Check that all of the master and slave computers have different computer names.

Changing the Computer
Name
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DHCP acquires automatically the IP address of DTG by default. To find the IP
address of a DTG unit, follow the steps below.

NOTE. Although it can be operated from a front panel with text input mode, if an
external keyboard and mouse are used, setting or changing the operation can be
performed easily

1. Press the CTRL+ESC keys to display the Start menu.

2. Select Programs/Accessories/Command Prompt by pressing the arrow
keys and press the ENTER key.

3. In the Command Prompt window, enter “ipconfig”. The IP Configuration
information will be displayed.

4. To exit the Command Prompt, enter “exit”.

If the IP address has been set manually, you can find the IP address from the
Internet Protocol setting dialog box as well as by using the Command Prompt
above.

1. Press the CTRL+ESC keys to display the Start menu.

2. Select Settings/Network and Dial--up Connections by pressing the arrow
keys and press the ENTER key.

3. In the Network and Dial--up Connections, select the Local Area Connec-
tion icon and press the ENTER key.

4. The Local Area Connection Status dialog box will be displayed. Select the
Properties button and press the ENTER key.

5. In the Components checked that are used by this connection: box, select
Internet Protocol (TCP/IP), then select the Properties button, and press the
ENTER key.

6. In the Internet Protocol (TCP/IP) Properties dialog box, the TCP/IP
information will be displayed. You can change the settings here.

To Find the IP address
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Setting the Master- Slave Operation

After checking that the master and the slaves have different computer names,
connect LAN cables and restart them. Use the DTG5000 Configuration Utility to
configure each DTG as a master or a slave.

First, quit the DTG5000 software at step1, next, start the DTG5000 Configura-
tion Utility software (Config.exe) by step2 through step6.

1. Select Exit (not ShutDown) from the File menu by pressing theMENU and
arrow keys to exit the DTG5000 software and return to the Windows
desktop.

2. Press CTRL + ESC to open the Start menu. Using the Up, Down, Left,
and/or Right arrow key, select Programs / Tektronix / DTG5000 /
DTG5000 Configuration Utility.

3. Select the OK button and press the ENTER key to start the DTG5000 Con-
figuration Utility.

Figure 1--56: Configuring as a slave in the Configuration Utility dialog box

4. Select Mode: Online by pressing the TAB key and the left or right arrow
key.

5. Select System Configuration: Slave by pressing the TAB key and the up or
down arrow key.

6. Select the OK button by pressing the TAB key and press the ENTER key to
exit the DTG5000 Configuration Utility.

7. Press the CTRL+ESC keys to display the Start menu. Select Programs/
Tektronix/DTG5000/DTG5000 by pressing the arrow keys and press the

Configuring DTG5000
Series as a slave
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ENTER key. The DTG5000 software will start. The DTG5000 Series unit
will start as a slave.

While the DTG5000 Series unit operates as a slave, the DTG5000--Slave dialog
box is displayed. At this time, all operations for the slave unit except for exiting
the DTG5000 software should be performed from the master unit.

Figure 1--57: Dialog box in operation as a slave

8. Pressing the ENTER key (selecting the Close button) on the slave unit exits
the DTG5000 software.

With the DTG5078 model as a master, two units of the same model can be set as
slaves. With the DTG5274 model, one unit of the DTG5274 model can be set as
a slave.

First, quit the DTG5000 software at step1, next, start the DTG5000 Configura-
tion Utility software (Config.exe) by step2 through step7.

1. Select Exit (not ShutDown) from the File menu by pressing theMENU and
arrow keys to exit the DTG5000 software and return to the Windows
desktop.

2. Press CTRL + ESC to open the Start menu. Using the Up, Down, Left,
and/or Right arrow key, select Programs / Tektronix / DTG5000 /
DTG5000 Configuration Utility.

3. Select the OK button and press the ENTER key to start the DTG5000 Con-
figuration Utility.

Configuring DTG5000
Series as a master
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Figure 1--58: Configuring as a master in the Configuration Utility dialog box

4. Set System Configuration toMaster/Slave#1 orMaster/Slave#1/Slave#2

by pressing the TAB key and the up or down key, according to the number
of slave units to be connected.

5. Specify the slave units to be connected in the Slave Computer Name area.
You can specify a unit by entering the Computer Name (Name) or the IP
address (IP address).

6. To specify the units with the names, select the Computer Name radio
button, press the ALPHA key to activate the text input mode, and enter the
names in the Slave #1 and Slave #2 combo boxes. You can also browse the
Network Computers by pressing the Browse button and specify the slave
units from the computers displayed.

7. To specify the slave units with the IP addresses, select the IP Address
button and enter the addresses using numeric keys.

8. When the setting is complete, select the OK button and press the ENTER
key to exit the DTG5000 Configuration Utility.

9. The following message prompting you to restart the DTG software will be
displayed:
“Please restart DTG software.”.

NOTE. Do not restart the DTG software until you read ”From Beginning to End

of Master--Slave Operation” beginning on page 1--106.
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From Beginning to End of Master- Slave Operation

During the Master--Slave operation, multiple DTG units are communicating
together through the LAN.

Before connecting the LAN cables, make sure that all the master and slave units
have their unique computer names on the network. If multiple DTG units have
the same name, rename them. If multiple units of computers have the same name
on the network, it can cause a trouble with the Master--Slave Operation.

After checking that each DTG unit has a unique computer name, connect the
LAN cables and restart the computers.

To configure the master and slave units, exit the DTG5000 software and use the
DTG5000 Configuration Utility.

� When you configure the master unit with the DTG5000 Configuration
Utility, you cannot browse the slave units unless the LAN cables are
connected.

� The computer names or the IP addresses are required to specify the slave
units.

After configuring the master and slave units using the DTG5000 Configuration
Utility, start the DTG5000 software on the slave units first, and then start it on
the master unit. The DTG5000 software on the master unit cannot start, until it
will detect that the DTG5000 Series that were specified as slave units operate
actually as its slaves.

� After the slave units and the master unit are started, the parameters for all
channels are displayed in the Channel Group, Data--Waveform, Data--Listing,
Timing, and Level windows on the master unit. Perform all operations on the
master unit such as assigning channels, creating and editing pattern data, and
setting each output parameter. The operations are the same as those in the
single unit system except for the increased number of channels that become
available on the master unit.

� DC Output is also output from the slaves.

� You can turn on or off the channels of all units by pressing the ALL
OUTPUTS ON/OFF button on the master unit. The ALL OUTPUTS
ON/OFF button can be operated only on the master unit.

� External Clock Out is output only from the master unit.

Before connecting the
LAN cables

Connecting the LAN
cables and starting the

computers

Configure the master and
slaves with the DTG5000

Configuration Utility

Restarting the DTG5000
software
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� The Pulse Generator mode during the Master--Slave operation is available
only for the channels of slots A to D on the master unit.

To terminate the Master--Slave operation, exit or shut down the master unit first
and then exit or shut down the slave units.

Terminating the
Master--Slave operation
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Pulse Generator mode

The DTG5000 Series Data Timing Generator operates as a pulse generator that
outputs a simple pulse pattern. The Pulse Generator mode is designed to easily
output simple pulse patterns. It does not support the editing feature that the Data
Generator supports.

To switch between the Data and Pulse Generator modes, push the PULSE GEN
button on the front panel, or click the Data Gen/Pulse Gen button at the left end
of the Status bar on the screen.

Features

The following are the features and restrictions of the Pulse Generator mode, as
well as the differences from the Data Generator mode:

� Use the Level, Timing, Time Base, and DC Output windows for setting
purposes.

� The Pulse Generator mode does not contain the concept of group or channel
assign. It sequentially uses all the channels of the installed output module.
However, you can switch the view between View by Group and View by
Group Channel.

� Even if you have set up Master--Slave operation, you can use only the
channel of the master machine.

� The Pulse Generator mode supports neither the sequence definition nor
pattern definition feature.

� You can use all the channels of the output modules installed in Slots A to D.

� You can specify the Pulse Rate to Off, 1/1, 1/2, 1/4, 1/8, or 1/16 for each
channel.

� You can select either Continuous or Burst for the run mode. The Continuous
mode merely outputs the pulse consecutively without waiting for the trigger.
The Burst mode outputs the pulse the specified number of times after
waiting the trigger. If you have set 9 (times) for Burst and 2 for Pulse Rate,
the analyzer outputs the pulse five times because it divides 9 by 2 and rounds
up the quotient (= 4.5).

� The Pulse Generator mode does not contain the concept of format (NRZ, RZ,
R1). While internally performing Long Delay with the RZ waveform, the
Pulse Generator mode controls Delay, Width, Slew Rate, and so on.
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� The Pulse Generator mode represents each channel in the format of
“mainframe number--slot name channel number”.
Examples: 1--A1, 1--A2, , 1--A4,1--B1,1--B2, , , 1--D1, , ,1--D4

� You can remotely change and set the operating mode and various options,
including the output level, in the Pulse Generator mode.

To control the data pattern, the following are possible:

� Timing Control: Pulse Rate, Pulse Width, Delay, Duty, Slew Rate, Polarity,
Channel Addition, Differential Timing Offset (Timing window)

� Level Control: Amplitude, offset (or combination of High and Low),
Term.R, Term. V (Level window)

Table 1--33 summarizes comparison between the Data and Pulse Generator
modes.
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Table 1--33: DTG5000 series key features

Key features Data Generator mode Pulse Generator mode

Data Rate
(Data Generator mode)

Frequency
(Pulse Generator mode)

DTG5078
NRZ only:
50 kbps to 750 Mbps
includes RZ or R1:
50 kbps to 375 Mbps

DTG5274
NRZ only:
50 kbps to 2.7 Gbps
includes RZ or R1:
50 kbps to 1.35 Gbps

DTG5078
50 kHz to 375 MHz

DTG5274
50 kHz to 1.35 GHz

Number of slots DTG5078: A to H

DTG5274: A to D

DTG5078: A to D

DTG5274: A to D

Available windows Time Base, Channel Group,
Blocks, Data--Listing, Data--Win-
dow, Timing, Level, Sequence,
Sub--sequences, Jitter Genera-
tion, DC Output

Time Base, Timing, Level, DC
Output

Channel Grouping � N/A

Data Format NRZ, RZ, R1 Pulse

Timing Control Delay, Pulse Width, Duty, Cross
Point, Slew Rate, Polarity

Delay, Pulse Width, Duty, Slew
Rate, Polarity, Pulse Rate

Level Control High, Low, High Limit, Low Limit,
Term. R, Term. V

High, Low, High Limit, Low Limit,
Term. R, Term. V

Sequence operation � N/A

Run mode N/A Continuous, Burst

Differential Timing Offset � �

Channel Addition AND, XOR AND, XOR

Long Delay � N/A

Jitter generation � N/A
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Time Base window

This window allows you to set the Clock Source, Clock Output, Run Mode, and
Trigger. In comparison with the Data Generator mode, the window has the
additional Run Mode settings, but does not have the Event signal settings.

Figure 1--59: Time Base window (Pulse Generator mode)

Table 1--34 shows setup items in the Time Base window.

Table 1--34: Setup items for Time Base window

Items Description

Clock Source Selects clock source.

Internal Use internal clock.

External 10MHz Refer-
ence

Use 10 MHz reference clock connected to 10 MHz Reference In.

External PLL Input: Use external PLL signal connected to Phase Lock In.

External Clock Input: Use signal connected to External Clock In as an external clock.

Clock Output Sets the clock output parameters.

Amplitude Sets clock output signal amplitude.

Offset Sets offset.

Term.R Sets termination impedance.

Term.V Sets termination voltage.
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Table 1--34: Setup items for Time Base window (cont.)

Items Description

Output On Specifies on/off of clock output.

Run Mode Continuous: Outputs the pulse consecutively when you press the
Run button.

Burst: Outputs the specified number of pulses you set in Burst Count
when a trigger event occurs.
Sets the event input signal parameters.

Burst Count Specifies the count of pulse output in the Burst mode (1 to 65,536).
Counts any pulse that is generated when Pulse Rate is 1.

Trigger Sets the trigger parameter. Available when you set Burst for Run
Mode.

Source Selects trigger source from internal/external.
Specifying Internal allows you to set the Interval.
Specifying External allows you to set the Level, Slope and
Impedance.

Slope Specifies the trigger point (rising edge or falling edge of external
trigger signal). Selects either Positive or Negative.

Impedance Specifies external trigger impedance. (50 Ω or 1 kΩ)

Interval Specifies internal trigger interval.

Level Specifies external trigger level.
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Level window

In this window, you can set the High/Low levels and the termination voltage or
impedance for logic channel. It also allows you to turn on or off the output. The
level of output signal can be specified by combining the High/Low levels or
Amplitude/Offset values.

Figure 1--60: Level window

The Level window allows you to set the following for each channel:

Table 1--35: Setup items for Level window

Items Description

High Sets the High level value.

Low Sets the Low level value.

H Limit Sets the High level limit value.

L Limit Sets the Low level limit value.

Limit Turns the High/Low feature on or off.

Term R Sets the termination impedance of the destination of the output
signal.

Term V Sets the termination voltage of the destination of the output signal.

Output Turns the output on or off.
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Timing window

This window allows you to set the time base related parameters such as the pulse
rate, clock frequency, delay, pulse width, and slew rate. The Data and Pulse
Generator modes differ in some parameters you must set.

The Pulse Generator mode is internally performing Long Delay; it does not
allow you to specify Long Delay. Based on the predefined table, the Pulse
Generator mode automatically and internally changes the clock range.

Figure 1--61: Timing window (Pulse Generator mode)

Table 1--36: Setup items for Timing window

Items Description

Frequency Sets the clock frequency of the data timing generator system. Either
Frequency or Period is available for this setting.

Delay Offset Sets the offset amount of the delay time. You can set a value from 0
to 3�s.

Internal Clock,
PLL Input,
External Reference
Input,
External Clock Input

Shows current clock source or the frequency of the external clock
signal.

Vector Rate Vector rate (viewed only)

CH Lists the channels of the currently installed output modules in order.
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Table 1--36: Setup items for Timing window (cont.)

Items Description

Pulse Rate Specifies 1, 1/2, 1/4, 1/8, 1/16, or Off (no output) for the pulse rate.

Delay Sets the lead delay (time or percentage).

PW/Duty Sets the pulse width or the duty. Any of Duty(%), Pulse Width(s) or
Trail Delay(s) is available for this setting.

Slew Rate Sets the slew rate (V/ns). Unavailable for any channel to which a
DTGM30 channel has been assigned.

Polarity Selects Normal or Invert for the polarity of the pattern.

Channel Addition Sets the channel addition. Selects from Normal, XOR, or AND.
If the odd CH is assigned to physical channel, Normal and XOR can
be selected. If the even CH is assigned to physical channel, Normal
and AND can be selected.

Diff. Timing Offset Shifts timing for only inverted side of differential output.
Sets differential timing offset on/off and timing volume.

The Pulse Generator mode allows you to specify the pulse rate within the range
from 1 to 1/16 for each channel. Changing the pulse rate causes the pulse shape
to change as shown below:

1/2

1/4

1/8

1/16

1

Pulse Rate

Figure 1--62: Pulse rate

The Bust Count in the Bust mode counts the number of pulses that are at pulse
rate 1. If you specify 9 for Burst Count, the analyzer outputs the pulse five times
for the channel of 1/2 pulse rate, because it divides 9 by 2 and rounds up the
quotient (= 4.5).

After a lapse of the delay time you set, the analyzer outputs the specified number
of pulses you set for Pulse Rate.

Pulse Rate

Burst Count
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The valid frequency range and step size vary depending on the clock source as
listed in Table 1--37.

Table 1--37: Valid frequency range and step size by clock source (Pulse Generator mode)

Clock Source Internal Ext 10 MHz Ref Input Ext PLL Input Ext Clock

External signal
frequency range

none 10 MHz¦ 0.1 MHz Fextpll = 1 MHz to
200 MHz

Fextcl =1 MHz to 750 MHz
(DTG5078)

Fextcl =1 MHz to 2.7 GHz
(DTG5274)

Clock Frequency
range

50 kHz to 375 MHz
(DTG5078)

50 kHz to 1.35 GHz
(DTG5078)

50 kHz to 375 MHz
(DTG5078)

50 kHz to 1.35 GHz
(DTG5078)

50 kHz <
Fextpll × N / Vector Rate
< 375 MHz
(DTG5078)

50 kHz <
Fextpll × N / Vector Rate
< 1.35 GHz
(DTG5078)

Fextcl / Vector Rate
(DTG5078)

Fextcl / Vector Rate
(DTG5078)

Frequency step 8 digits 4 digits Fextpll / Vector Rate 0 (fixed)

Frequency Range and
Step Size
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DC Output window

In this window you can set the parameters of the DC output located at the front
right of the data timing generator. Eight channel DC outputs are equipped with a
mainframe. While the system configuration is in Master-Slave mode, the master
machine can control the DC Outputs of all the slave machines.

Figure 1--63: DC Output window

The DC Output window allows you to set the following for each channel:

Table 1--38: Setup items for DC Output window

Items Description

Level Sets the DC level value.

H Limit Sets the maximum value of DC level setting range.

L Limit Sets the minimum value of DC level setting range.

Limit Turns the High/Low limit function on or off.

Output On Selects on or off for the output.

DC Output Window
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Offline mode

The DTG5000 software runs on an ordinary PC as well as a DTG5000 Series
mainframe. Running and using this software on PCs is called the Offline mode.

The Offline mode allows you to create and edit pattern data and set the output
parameters. By saving the result of a setting file and loading in the DTG5000
series, a pattern can be output.

Operating Environment

� OS

� Windows 2000 SP3

� Windows XP Professional

� Internet Explorer 5.0 or later

� Display Requirements

� Colors: High Color (16 bits or higher)

� Definition: 800 x 600 pixels or higher

Installing the DTG5000 Software on Your PC

The DTG5000 software is included in the DTG5000 Series Product Software
CD--ROM that is supplied with the DTG5000 Series Data Timing Generator.
Log on the instrument with the administrator name to install the DTG5000 soft-
ware.

NOTE. The DTG5000 software supports Windows 2000 Service Pack 3 or later

and Windows XP Professional.

You can install the software on an unlimited number of PCs.

The DTG5000 software is not available in hibernation mode. If your PC

(including a notebook PC) enters the sleep or suspend mode during operation,

we do not guarantee normal operation of the DTG5000 software after the

restoration.
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1. Load the DTG5000 Series Product Software CD--ROM in the CD--ROM
drive. The installer starts automatically. If it does not start, double--click the
setup.exe icon to start the installer.

2. The message “Welcome to the InstallShield Wizard for Tektronix....”
appears. Click Next.

3. The message “Choose Destination Location.” appears. Select the directory in
which you want to install the software. Click Next.

4. The Select Program Folder appears. Select the folder in which to create a
shortcut icon of the program. Click Next.

5. The message “Start Copying Files” appears. Click Next.

6. The message “InstallShield Wizard Complete” appears. Click Finish.

Uninstalling DTG5000 Software

To uninstall the software, use the Add/Remove Programs dialog box in the
Control Panel. Log on the instrument with the administrator name to uninstall
the DTG5000 software.

Starting the DTG5000 Software in Offline Mode

To enable the software to start in Offline mode, use the DTG5000 Configuration
Utility for setup.

1. If the DTG5000 software is running, press theMENU key and select Exit
from the File menu to exit the software.

2. Press the CTRL + ESC keys to open the Start menu. Using the Up, Down,
Left, and/or Right arrow key, select Programs / Tektronix / DTG5000 /
DTG5000 Configuration Utility.

3. Press the ENTER key to start the DTG5000 Configuration Utility. If the
window for the Online mode opens, select the Offline checkbox in the Mode
area.
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Figure 1--64: DTG5000 Configuration Utility Offline mode

4. Using the Offline mode DTG5000 Configuration Utility, set up the system
configuration including the output modules and the Master--Slave configura-
tion. For details of the DTG5000 Configuration Utility, see “DTG5000
Configuration Utility” on page 1--91.

5. Click OK to exit the DTG5000 Configuration Utility.

6. In the Start menu, select Programs / Tektronix / DTG5000 /DTG5000 to
start the DTG5000 software in Offline mode.
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Remote Control
The DTG5000 Series supports GPIB interface. The GPIB enables up to 15
devices (including the controller) to be connected for concurrent use. With the
DTG connected with an external computer via GPIB, you can use the computer
as the controller to remotely control your DTG5000 Series . The DTG5000
Series is not available as the controller. For control with the GPIB, refer to the
Programmer’s Manual.

The DTG5000 Configuration Utility software is independent of the DTG5000
software. This utility allows you to switch the DTG5000 software between
online and offline or set up Master--Slave operation.

GPIB parameters
To use the GPIB, the DTG5000 Series requires you to set only the GPIB address.
This address is a number that allows the software to identify each device
connected. You must specify a unique number from 0 to 30 for each device.

To set the GPIB address, you can use either the DTG5000 Configuration Utility
or the System menu in the menu bar. The setting procedure is the same.

Remote Control dialog box DTG5000 Utility Configuration

Figure 1--65: Setting the GPIB address

Using the DTG5000 Configuration Utility for setting

1. If the DTG5000 software is running, press theMENU key and select Exit
from the File menu to exit the software.

2. Press CTRL + ESC to open the Start menu. Using the Up, Down, Left,
and/or Right arrow key, select Programs / Tektronix / DTG5000 /
DTG5000 Configuration Utility.

Setting the GPIB address



Remote Control

1--124 DTG5078 & DTG5274 Data Timing Generator User Manual

3. Press the ENTER key to start the DTG5000 Configuration Utility. The
utility provides you with two windows: for Online and Offline modes. If the
utility opens the Offline mode dialog box, select Online in the Mode area.

4. Using the TAB key, activate the Address box in Remote Control. Then, set
the numeric value using the Up and/or Down arrow key.

5. Press the ENTER key to exit the DTG5000 Configuration Utility. In the
Start menu, select Programs / Tektronix / DTG5000 /DTG5000 to start the
DTG5000 software.

Using the System menu for setting

You can change the address while the DTG5000 software is running.

1. Press the MENU key. Next, select Remote Control... in the System menu.
Then press the SELECT key.

2. The Remote Control dialog box appears. Using the TAB key, activate the
Address box. Then, set the numeric value using the Up and/or Down arrow
key.

3. Press the ENTER key to close the dialog box. The address you have just set
takes effect immediately.

GPIB Driver
Note the following about the GPIB board and driver software.

NOTE. The DTG5000 Series contains the National Instruments GPIB board and

driver software. They are used to control the DTG5000 Series from the external

controller.

While the DTG5000 software is running, you cannot use any GPIB device in

order to control another external device.

CAUTION. About the GPIB Driver Version:

The DTG5000 Series are shipped with the Version 1.7 GPIB drivers with the

system operation capabilities that have been confirmed with the test using the

drivers.

If you install National Instruments LabView or other software on the DTG5000
Series, this may change the version of the driver of the GPIB board.

If you want to install such software on your DTG5000 Series, skip installation of

the GPIB driver to avoid the overwrite.
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Diagnostics and Calibration

This section describes Diagnostics, Calibration and two checking features, which
are available on the DTG5000 Series. These test items are located in the System
menu.

Diagnostics

Diagnostics is a hardware diagnostic feature that executes a comprehensive test
on the DTG5000 Series. Usually, the feature automatically executes the
diagnostic test when you power on the DTG5000 Series. You can also have this
feature execute the test, if necessary, through the System menu or using remote
commands. By executing the diagnostic test, you can verify whether the
hardware is running normally. The Diagnostics feature of DTG5000 Series
diagnoses the following items:

� Registers

� Clocks

� Outputs

� Sequence memory

� Pattern memory

Diagnostics on slave machines are not executed individually, but they are
executed simultaneously on the master machine.

When you power on the DTG5000 Series, it automatically executes a diagnostic
test for all the diagnostics items, except the pattern memory cell test, while the
Startup window remains on--screen. When detecting an error, this test displays an
error message. If you see such a message, press the ENTER key and click the
OK button to proceed with the next step. The DTG5000 software starts. When
the DTG5000 Series contains an unsolved error, the test cannot be conducted
normally. In such a case, contact our Customer Service Center.

Power On Diagnostic Test
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When you select Diagnostics... in the System menu, the Diagnostics dialog box
appears. This box lists the results of the power--on or the latest diagnostic test.
This test allows you to select the desired diagnostic items and the number of
repetitions.

Figure 1--66: Diagnostics dialog box

Table 1--39: Diagnostics dialog box buttons

Button Description

Execute All Items Executes diagnostics on all the test items.

Execute Selected Items Executes diagnostics on one or more consecutive test items you
selected. To select a test item, use the Up and/or Down arrow key.
To select two or more items, use the Up and/or Down arrow key
while holding down the SHIFT key.

Loop until Fail If you select this checkbox, the diagnostic test repeats until it
detects any fail. To cancel the test, click the Cancel button.

Cancel Stops the test that is running. Available only during the test.

Close Closes the dialog box.

Diagnostic Test from
Menu
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1. If you want to execute all the test items, click the Execute All Items button.

If you want to execute only the desired test items, select them by using the
Up and/or Down arrow keys holding the SHIFT button, and then click the
Execute Selected Item button.
If you select the Loop Until Fail checkbox, the diagnostic test repeats until
it detects Fail.

2. Press the ENTER key to start the diagnostics.

The diagnostic test resets all the hardware settings to the defaults. Before the
test begins, you see a confirmation dialog box that asks you whether you
want to save the current settings. Choose to save the settings, if necessary.

3. When the test is finished, the results are listed. Select the Close button.
Then, press the ENTER key to close the dialog box.

Status lists the diagnostic results. When the DTG5000 Series contains an
unsolved error, it cannot operate normally. In such a case, contact our Customer
Service Center.

Table 1--40: Information on Status

Status Description

Pass The DTG5000 Series is operating normally.

Unknown The results are unknown because the test has not finished yet. As
the power--on diagnostic test can diagnose only part of the pattern
memory, this message is displayed.

Fail (xxxxxxx) The test detected an error. xxxxxxx represents an error code.

Executing Now executing.

If Diagnostics detects a malfunction, it displays character string “Fail” and the
error code. The error code consists of a five--digit code and three arguments. The
five--digit code consists of the mainframe number, the category, and the board
and slot positions. The three arguments include supplementary information
which depends on the code.

Operating Procedure

Diagnostic Results

Error Codes
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Mainframe number

15112, 0xNN, 0xNN, 0xNN

Category

Slot position

Argument1

Argument2

Argument3

Board position

Slot position

Upper
Board position

Lower

DTG5078 DTG5274

Upper

x0 x0x1 x1x2 x2x3 x3

0x 0x

1x

A A

B

BC C

D

DE

F

G

H

Figure 1--67: Diagnostics error code format

In such a case, DTG5000 Series cannot operate normally. Contact our Customer
Service Center.



Diagnostics and Calibration

DTG5078 & DTG5274 Data Timing Generator User Manual 1--129

LCD Panel Check

This test turns the entire screen area white, black, red, green, and blue in order.
When the screen displays these colors, you can verify that the LCD operates
normally.

1. Select LCD Panel Check... in the System menu. Then, press the SELECT
key. The entire screen area turns white.

2. Press the ENTER key (or any key), repeatedly. The color of the screen area
changes in order. After it turns blue, the DTG5000 software screen returns.

Front Panel Key Check

This test checks operation of all the keys, except Power On keys, and the knob
on the front panel.

1. Select Front Panel Key Check... in the System menu. Then, press the
SELECT key. The dialog box appears as shown in Figure 2--70.

2. Pressing a key on the front panel turns the key light blue, with the key name
displayed in the screen area. When the view in the dialog box changes in this
manner, you can verify that each key and the knob operate normally as a
hardware component.

3. Press the ENTER key twice, or click the OK button to terminate the key
check.

Figure 1--68: Front Panel Key Check dialog box

Operating Procedure

Operating Procedure
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Skew Calibration

The Skew Calibration compensates for the propagation delay times of output
signals from each channel which are caused by differences in the attributes and
the length of the cables connected to the DTG5000 Series and its circuitry. This
feature then provides proper timing at the output cable ends.

Without requiring any external measuring equipments, this feature measures and
calibrates the timing by returning the DTG5000 Series output signals to SKEW
CAL IN. The calibration works at the level of ECL into 50 Ω to --2 V.

In addition, it can adjust the timing of the output signals from two or more
DTG5000 Series by calibration in the Master--Slave configuration.

NOTE. For a DTGM30 output module of differential output (Complementary),
the amount of calibration for the inverted channels is the same as the normal
channels. Thus, the delay time caused by the cables of the normal channels is
reflected on the amount of calibration for the inverted channels.

The Skew Calibration does not cover the Clock Output.

There is no restriction for the length of cables to use as same length of each
other. The range for which the calibration works is up to approximately 1.5 ns in
the circuitry in a DTG5000 Series, or 500 ps (= 10 cm) in dispersion of cable
length. This feature regards a more dispersion as an error.

The DTG5000 Series performs calibration for the cables connected to its internal
circuitry and to the output connectors, the cables connected to the CLK and
JUMP used for controlling the slave machines (in Master--Slave operation), all
the signal paths, and the temperature conditions during operation, etc. Thus, you
should perform Skew Calibration in the following cases:

� You changed a cable to use, including a cable used for connection with the
master or a slave machine in Master--Slave operation.

� You changed an output module slot position.

� The system configuration changed (e.g., addition or removal of output
module; or Master--Slave operation).

� The temperature at which you actually use the analyzer changed.

Calibration Range

Cases when you should
perform
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Perform the calibration according to the instructions shown in the screen.
Reconnect the cable from the output channel connected to SKEW CAL IN
before beginning.

Before starting calibration

1. Power on the DTG5000 Series mainframe. Warm up the mainframe for 20
minutes at the normal operating temperature.

2. Install the output modules in the slots you want to use, and connect the
cables to the associated channels. For the Master--Slave operation, set the
hardware components so that the controlling CLK and JUMP signal cables
are also connected for using the DTG5000 Series mainframe.

3. The Skew Calibration clears all the created pattern data and settings. So,
before proceeding with the execution, you should save the settings as
necessary. The Skew Calibration shows this warning message immediately
before it starts.

Starting calibration

1. Make sure that no signals are being output. If the RUN button indicator
remains lit up, push this button to stop the output. Even if one output module
LEDs remains lit up, push the ALL OUTPUTS ON/OFF button and check
that all the output connector LEDs have gone out.

Execute Skew Calibration using the following procedure. Check that no error
message appears.

2. Select Skew Calibration... in the System menu. Then, press the SELECT
key. The dialog box appears.

Operating Procedure
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Figure 1--69: Skew Calibration dialog box

The dialog box lists the current calibration constants. The table below summa-
rizes the button functions.

Table 1--41: Skew Calibration dialog box buttons

Button Description

Execute Initiates the calibration.

Cancel Stops execution of the calibration. Available only in execution. Use
of this button clears all the calibration data currently being
executed; the initial calibration data returns.

Clear Clears all the calibration data that the DTG5000 Series currently
retains. The calibration data returns to the initial values.

Close Closes the dialog box.

3. Select/Click the Execute button. You cannot choose to execute the calibra-
tion in one or more channels or slots.

4. According to the message instructions, connect the SKEW CAL IN

connectors on the front panel (of the master also in the Master--Slave
operation) to the OUTPUT connectors on the output module channels. Once
you have finished the connections, click OK. For connection between
SKEW CAL IN and the output module channels, use the cables of actual
use.
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Figure 1--70: Example of cable connection message

If you perform erroneous operations, you may receive a warning message.

Figure 1--71: Example of warning message

If the calibration does not completely succeed, the error message dialog box
appears.

Figure 1--72: Example of error message

The table below summarizes the functions of the message buttons above.
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Table 1--42: Skew Calibration Warning buttons

Button Description

Abort Returns to the calibration window. Use of this button clears the
calibration constants of the channels on which the calibration has
worked up to then; the initial calibration constants return.

Retry Retry the calibration on the current channel.

Ignore Proceeds with the next step/channel, ignoring the calibration on
the current channel.

5. Executes the calibration on all the channels of the currently installed output
modules.

The Status (Value) column lists the calibration times and coefficients. Check
that all the calibration times are in the 0 ps to 1.5 ns range.

6. Select the Close button. Then, press the ENTER key to terminate Skew
Calibration.

CAUTION. Powering off the DTG5000 Series during calibration may clear the

calibration data from memory.
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Level Calibration

Level Calibration calibrates the levels of the output signals in the total circuitry
that contains the DTG5000 Series and output modules combined. This calibra-
tion does not require any cables or measuring equipments.

The DTG5000 software automatically executes Level Calibration every time it
starts. If you have set up the DTG5000 Series for Master--Slave operation, an
attempt to start the master machine (that is, the slave machine is already operating)
causes Level Calibration to work on all the channels of the master and slave
machines.

An output level is affected by an environmental temperature. Thus, you should
perform Level Calibration in the following cases:

� The temperature of the DTG5000 Series mainframe varies during operation.

� An accuracy is required when you output the signal.

You can perform the calibration only by clicking the Execute button on the screen.

Before starting calibration

Power on the DTG5000 Series main frame. Warm up the mainframe for 20
minutes at the normal operating temperature.

Starting calibration

1. Select Level Calibration... in the System menu. Then, press the SELECT
key. The Level Calibration dialog box appears.

Cases when you should
perform

Operating Procedure
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Figure 1--73: Level Calibration dialog box

Status in the dialog box lists the results of the calibration at the time that the
DTG5000 software started (or the results of the latest calibration).

2. Select/Click the Execute button to initiate the calibration. You cannot choose
specific channels or slots to execute the calibration.

3. The Status column shows the result of the calibration as “Pass” or “Fail”.
Check that “Pass” appears for all the channels.

4. Select the Close button. Then, press the ENTER key to terminate Level
Calibration.
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Appendix A: Setting Up the Display Device

This section describes how to set up the DTG5000 Series Data Timing Generator
when connecting an external monitor to it.

Selecting the Device

1. Connect the monitor cable and mouse to the DTG5000 Series mainframe.
Then power on the mainframe.

2. In the Start menu, select Settings / Control Panel. Click the Display icon in
the Control Panel.

3. In the Display Properties dialog box, click the Settings tab and click the
Advanced... button.

Figure A--1: Display Properties dialog box

4. In the Default Monitor and Intel(R) 82815 Graphics Controller Properties
dialog box, click the Intel(R) Graphics Technology tab.
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Figure A--2: Default Monitor and Intel (R) 82815 Graphics Controller Properties
dialog box

5. In Intel(R) Graphics Technology tab, click the Graphics Properties...
button.

Figure A--3: Intel (R) Graphics Technology tab
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6. The Intel(R) 82815 Graphics Controller Properties dialog box opens. Click
the Device tab. Select and set the display device here.

Figure A--4: Intel (R) 82815 Graphics Controller Properties dialog box

7. Select the device icons you want on the left.

Table A--1: Selecting the display device

Items Description

Monitor Enables only the external monitor.

Digital Display Enables the display of the DTG5000 Series main unit.

Inter (R) Dual Display
Twin

The display screen of the DTG5000 Series main unit and the
external monitor display same image.

8. Select the Activate xxx checkbox at the bottom left corner. Then click OK

9. The device you specified is enabled, then the confirmation dialog box
appears. Click OK within 15 s to determine the device change.
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Figure A--5: Confirmation dialog box

10. The screen returns to the display shown in Figure A--4.

Display Definition

If the display device of the DTG5000 Series is enabled, the display definition
including the external monitor is up to 800 x 600.

1. If only the external monitor is enabled, you can set the definition for up to
1,600 x 1,200. In the dialog box shown in Figure A--4, click again the
Graphics Properties... button. In the Intel(R) 82815 Graphics Controller
Properties dialog box, set the definition in the Screen area on the Device tab.

Figure A--6: Setting the definition of the external monitor

2. Click OK to change the definition. The confirmation dialog box appears.
Click OK within 15 s to determine the change.

3. Click OK to close the dialog box.
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Appendix B: System Recovery

If the operating system no longer can start due to some cause, you have to
recover the OS by starting it from the recovery disk supplied with the OS.
Recovering the system using the recovery disk deletes the entire data from the
hard disk.

For this reason, you have to perform the following operations:

� Reinstalling the Windows 2000 operating system

� Setting up the Windows 2000 operating system

� Reinstalling the DTG5000 software

Requirements for System Recovery

Prepare the following:

� Recovery disk labeled “Windows 2000 Professional Operating System
Recovery Disk”

� Application installation disk labeled “DTG5000 Series Product Software”

The system cannot recognize any USB device during operation with the recovery
disk. Thus prepare the following as well:

� PS/2 keyboard and PS/2 mouse

Operating Procedure

CAUTION. Recovering the system using the recovery disk deletes the entire data

on the hard disks.

Back up the necessary data on a routine basis to avoid data loss.

1. With the power off, connect the PS/2 keyboard and PS/2 mouse to the
connectors on the rear panel.

2. Power on the unit.

3. Load the recovery CD--ROM in the CD--ROM drive on the rear panel.

Installing the Windows
2000 Operating System
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4. Power off the DTG5000 Series once. Then power it on again. The system
starts from the recovery disk.

5. The “PowerQuest EasyRestore End User License Agreement” window
appears.
Press any key as instructed in the message.

6. The EasyRestore dialog box opens. Click the Continue button.

7. The Warning dialog box opens. Click Yes.

8. After the entire image data in the drive has been copied, the Reboot dialog
box opens. Remove the recovery CD--ROM from the drive, and then click
the Reboot button.

9. The system restarts, and Windows 2000 Setup begins.
Go to the next step, “Setting Up Windows 2000.”

1. The Windows 2000 setup wizard “Welcome to the Windows 2000 Setup
Wizard” appears on the data timing generator screen.

2. Click the Next button, the “License Agreement” dialog box appears.

3. Follow the on-screen instructions.

4. When the “Personalize Your Software” dialog box appears, “Name” and
“Organization” have added. Be sure to input “Name”. “Organization” can be
left blank.

5. Click the Next button.

6. When “Your Product Key” dialog box appears, enter the bar code number
which is located at the rear panel of the mainframe.

7. Click the Next button to display the Date and Time Settings dialog box.

8. Confirm that the Date and the Time Settings information is correct, and the
click the Next button.

9. The dialog box informs you the completion of Windows 2000 setup.

10. Click Restart Now, and Windows runs.

The computer name is DTG5000, and you can log on the Windows 2000 as the
following user name and password.

� User name: Administrator

� Password: dtg5000

Setting Up Windows 2000
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If you want to add the user name, or want to change the password, always use
the Control Panel --> Users and Passwords. For more information, consult
Windows 2000 Help.

NOTE. If you connect the second or third DTG5000 series data timing generator

to the network, use different computer names for additional instruments.

1. Load the “DTG5000 Series Product Software CD--ROM” in the CD--ROM
drive. The installer starts automatically. If it does not start, double--click the
setup.exe icon to start the installer.

2. The message “Welcome to the InstallShield Wizard for Tektronix...” appears.
Click Next.

3. The message “InstallShield Wizard Complete” appears. Click Finish.
Windows 20000 operating system restarts when you reinstall the system
software using the system recovery disk.

Reinstalling the DTG5000
Software
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Appendix C: Inspection and Cleaning

Inspect and clean the instrument as often as operating conditions require. The
collection of dirt can cause instrument overheating and breakdown. Dirt acts as
an insulating blanket, preventing efficient heat dissipation. Dirt also provides an
electrical conduction path that can cause an instrument failure, especially under
high-humidity conditions.

CAUTION. To prevent damage avoid the use of chemical cleaning agents that

might damage the plastics used in this instrument. Use only deionized water

when cleaning the front-panel buttons. Use a ethyl alcohol solution as a cleaner

and rinse with deionized water.

Avoid the use of high pressure compressed air when cleaning dust from the
interior of this instrument. (High pressure air can cause ESD.) Instead, use low

pressure compressed air (about 9 psi).

Using Table C--1 as a guide, inspect the outside of the instrument for damage,
wear, and missing parts. You should thoroughly check instruments that appear to
have been dropped or otherwise abused to verify correct operation and perfor-
mance. Immediately repair defects that could cause personal injury or lead to
further damage to the instrument.

Table C--1: External inspection check list

Item Inspect for Repair action

Cabinet, front panel, and cover Cracks, scratches, deformations, damaged
hardware or gaskets

Replace defective module

Front-panel knobs Missing, damaged, or loose knobs Repair or replace missing or defective knobs

Connectors Broken shells, cracked insulation, and
deformed contacts. Dirt in connectors

Replace defective modules; clear or wash out
dirt

Carrying handle and cabinet feet Correct operation Replace defective module

Accessories Missing items or parts of items, bent pins,
broken or frayed cables, and damaged
connectors

Replace damaged or missing items, frayed
cables, and defective modules

Inspection — Exterior
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WARNING. To avoid injury or death, unplug the power cord from line voltage

before cleaning the instrument. To avoid getting moisture inside the instrument

during external cleaning, use only enough liquid to dampen the cloth or applica-

tor.

1. Remove loose dust on the outside of the instrument with a lint-free cloth.

2. Remove remaining dirt with a lint free cloth dampened in a general purpose
detergent-and-water solution. Do not use abrasive cleaners.

3. Clean the monitor screen with a lint-free cloth dampened with either ethyl
alcohol or, preferably, a gentle, general purpose detergent-and-water solution.

Only qualified personnel should access the inside of the DTG5000 Series for
inspection and cleaning, refer to the Maintenance section in the DTG5000 Series
service manual.

Cleaning Procedure —
Exterior

Cleaning the
Instrument Interior
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B
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Clock Source, 1--37
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Copy, Edit menu, 1--23
Copy to Clipboard, Edit menu, 1--30
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Resolution, 1--52
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RZ, 1--36
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Data Structure
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DC Output pin assign, 1--69
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Predefined Level, 1--71
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Diagnostics, 1--125
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Power On Diagnostics, 1--125
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Execute Selected Items, 1--126
Loop until Fail, 1--126

Diagnostics status
Executing, 1--127
Fail, 1--127
Pass, 1--127
Unknown, 1--127

Differential Timing Offset, 1--59
DTG5000 Configuration Utility, 1--91
Mainframe, 1--94
Master Slot Configuration, 1--95
Remote Control, 1--93
Set by, 1--93
Slave, 1--93
Slave Slot Configuration, 1--95
System Configuration, 1--93

DTO, 1--59
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E
Edit menu, 1--23
Clock Pattern, 1--24
Copy, 1--23
Copy to Clipboard, 1--30
Fill with One, 1--24
Fill with Zero, 1--24
Invert, 1--23
Mirror, 1--23
Paste, 1--23
Paste from Clipboard, 1--30
PRBS, 1--28
Predefined Pattern, 1--24
PRWS, 1--28
Shift.Rotate, 1--24

Edited Area, 1--16
By, 1--16
Range, 1--16

Delay Offset, 1--46
External 10MHz Refernce, Clock Source, 1--37
External Clock Input, Clock Source, 1--38
External PLL Input, Clock Source, 1--38

F
Fill with One, Edit menu, 1--24
Fill with Zero, Edit menu, 1--24
Frequency Range, 1--39
Frequency Step Size, 1--39
Area, 1--15
Front Panel Key Check, 1--129

G
Graycode Counter, Predefined Pattern, 1--25
Group, 1--7, 1--10
Group List, 1--11
Grouping, 1--10

H
HFS Vector Files, Import, 1--33

I
iew, Zoom, 1--20
Import
HFS Vector Files, 1--33
TLA Data Exchange Format, 1--31

inspection, exterior, C--1

inspection and cleaning, C--1
compressed air, C--1

Interior inspection, procedures, C--2
Internal, Clock Source, 1--37
Introduction, to this manual, xiii
Invert, Edit menu, 1--23

J
Jitter Generation
All Pattern Jitter, 1--84
Delay line, 1--84
Gate on area, 1--86
Jitter on area, 1--86
on the DTG5000 series, 1--83
Partial Pattern Jitter, 1--86

Jitter Generation window
Amplitude, 1--89
Edge, 1--88
Frequency, 1--89
Jitter Generation in Slot A CH1, 1--88
Profile, 1--88
Unit, 1--89

Johnson Counter, Predefined Pattern, 1--25
Jump Mode
Command jump, 1--78
Event jump, 1--78
Sync, 1--78

Jump Timing, Aync, 1--78

L
LCD Panel Check, 1--129
Level Calibration, 1--135
Level window
Amplitude, 1--64
H Limit, 1--66
High Level, 1--64
L Limit, 1--66
Low Level, 1--64
Output On/Off, 1--67
Output Voltage, 1--64
Predefined Level, 1--68
Term. R, 1--67
Term.V, 1--67

Logical Channel, 1--6
Long Delay, 1--53

M
Magnitude, Properties, 1--22
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Manuals, related, xiv
Mark Density, 1--29
Marker, 1--18
Moving a Marker, 1--19

Master--Slave Operation
Cable connection, 1--97
Changing the Computer name, 1--101
Configuration, 1--103
Find the IP address, 1--102

Mirror, Edit menu, 1--23

N
NRZ, Data format, 1--36

O
Offline mode, 1--92, 1--119
Online mode, 1--92
Operating Mode
Data Generator Mode, 1--2
Pulse Generator Mode, 1--2

Output Level, 1--63

P
Paste, Edit menu, 1--23
Paste from Clipboard, Edit menu, 1--30
Pattern Edit
Area, 1--15
Defining an Area, 1--19
Select Block, 1--22
View, 1--20

Phone number, Tektronix, xv
Physical Channel, 1--6
PLL Clock Multiple Rate, 1--44
Polarity, 1--62
PRBS, Edit menu, 1--28
PRBS/PRWS
Invert, 1--30
Mark Density, 1--29
Pattern, 1--29
Type, 1--29

Predefined DC level
CML, 1--71
CMOS 3.3V, 1--71
CMOS 5V, 1--71
ECL, 1--71
LVDS, 1--71
LVPECL, 1--71
PECL, 1--71

RSL, 1--71
TMDS, 1--71
TTL, 1--71

Predefined Level
CML, 1--68
CMOS 3.3V, 1--68
CMOS 5V, 1--68
ECL, 1--68
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PECL, 1--68
RSL, 1--68
TMDS, 1--68
TTL, 1--68

Predefined Pattern
Binary Counter, 1--25
Checker Board, 1--25
Direction, 1--25
Edit menu, 1--24
Graycode Counter, 1--25
Johnson Counter, 1--25
Step, 1--25
Stop, 1--25
User Defined Pattern, 1--27
Walking Ones, 1--25
Walking Zeros, 1--25

Procedure, inspect interior, C--2
Product support, contact information, xv
Properties, 1--21
Magnitude, 1--22
Radix, 1--21
Signed, 1--21

PRWS, Edit menu, 1--28
Pulse Generator Mode, 1--2
Pulse Generator mode, 1--109
Burst, 1--113
Burst Count, 1--113, 1--116
Continuous, 1--113
DC Output window, 1--118
Frequency Range, 1--117
Frequency Step Size, 1--117
Install, 1--119
Level window, 1--114
Operating Environment, 1--119
Pulse Rate, 1--116
Run Mode, 1--113
Starting the software, 1--120
Time Base window, 1--112
Timing window, 1--115
Uninstall, 1--120

Pulse Parameters, 1--45
Delay Offset, 1--46
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Duty, 1--45, 1--49
Lead Delay, 1--45, 1--48
Period, 1--45
Phase, 1--45, 1--48
Pulse Width, 1--45, 1--50
Trail Delay, 1--45, 1--49

Pulse Rate, 1--116

R
R1, Data format, 1--36
Radix, Properties, 1--21
Rage, Edited Area, 1--16
Related Manuals, xiv
Remote Control, 1--123
GPIB address, 1--123
GPIB driver, 1--124
GPIB parameters, 1--123

RZ, Data format, 1--36

S
Select Block, 1--22
Sequence, 1--8, 1--75
Jump Mode, 1--78
Jump Timing, 1--78
Sequencer Mode, 1--77

Sequence window
Block, 1--80
Event Jump To, 1--80
Go To, 1--80
Inf., 1--80
Jump Mode, 1--79
Jump Timing, 1--79
Label, 1--79
Repeat, 1--80
Sequence Mode, 1--79
Sub--sequence, 1--80
Wait Trig., 1--79

Sequencer Mode
Hardware Sequencer, 1--77
Software Sequencer, 1--77

Service support, contact information, xv
Shift/Rotate, Edit menu, 1--24
Signed, Properties, 1--21
Skew Calibration, 1--130
Skew Calibration dialog box
Cancel, 1--132
Clear, 1--132

Close, 1--132
Execute, 1--132

Slew Rate, 1--51
Range, 1--51
Resolution, 1--51

Sub--sequences window, 1--81
Block, 1--82
Repeat, 1--82

Subsequence, 1--81
Sync, Jump Mode, 1--78

T
Technical support, contact information, xv
Tektronix, contacting, xv
Termination Resistor, 1--67
Termination Voltage, 1--67
TLA Data Exchange format, Import, 1--31
Trigger, 1--73
Impedance, 1--74
Internval, 1--74
Level, 1--74
Manual Trigger button, 1--73
Slope, 1--74
Source, 1--74

U
URL, Tektronix, xv
User Defined Pattern, Predefined Pattern, 1--27

V
Vector Rate, 1--43
View
Display order, 1--21
Properties, 1--21
View by Channel, 1--20
View by Group, 1--20
View with Timing, 1--21

W
Walking Ones, Predefined Pattern, 1--25
Walking Zeros, Predefined Pattern, 1--25
Web site address, Tektronix, xv
window, Channel Group, 1--11
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